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Copyright © Tektronix. All rights reserved. Licensed software products are owned by Tektronix or its subsidiaries or suppliers, and are
protected by national copyright laws and international treaty provisions.
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TEKTRONIX and TEK are registered trademarks of Tektronix, Inc.
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LTE is a trademark of ETSI.

Contacting Tektronix

Tektronix, Inc.

14150 SW Karl Braun Drive
P.O. Box 500

Beaverton, OR 97077

USA

For product information, sales, service, and technical support:
= In North America, call 1-800-833-9200.
= Worldwide, visit www.tektronix.com to find contacts in your area.


http://www.tektronix.com/contact

Warranty

Tektronix warrants that this product will be free from defects in materials and workmanship for a period of one (1) year from the date of
shipment. If any such product proves defective during this warranty period, Tektronix, at its option, either will repair the defective
product without charge for parts and labor, or will provide a replacement in exchange for the defective product. Parts, modules and
replacement products used by Tektronix for warranty work may be new or reconditioned to like new performance. All replaced

parts, modules and products become the property of Tektronix.

In order to obtain service under this warranty, Customer must notify Tektronix of the defect before the expiration of the warranty period
and make suitable arrangements for the performance of service. Customer shall be responsible for packaging and shipping the
defective product to the service center designated by Tektronix, with shipping charges prepaid. Tektronix shall pay for the return of the
product to Customer if the shipment is to a location within the country in which the Tektronix service center is located. Customer shall
be responsible for paying all shipping charges, duties, taxes, and any other charges for products returned to any other locations.

This warranty shall not apply to any defect, failure or damage caused by improper use or improper or inadequate maintenance and
care. Tektronix shall not be obligated to furnish service under this warranty a) to repair damage resulting from attempts by personnel
other than Tektronix representatives to install, repair or service the product; b) to repair damage resulting from improper use or
connection to incompatible equipment; ¢) to repair any damage or malfunction caused by the use of non-Tektronix supplies; or

d) to service a product that has been modified or integrated with other products when the effect of such modification or integration
increases the time or difficulty of servicing the product.

THIS WARRANTY IS GIVEN BY TEKTRONIX WITH RESPECT TO THE PRODUCT IN LIEU OF ANY OTHER WARRANTIES,
EXPRESS OR IMPLIED. TEKTRONIX AND ITS VENDORS DISCLAIM ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR
FITNESS FOR A PARTICULAR PURPOSE. TEKTRONIX' RESPONSIBILITY TO REPAIR OR REPLACE DEFECTIVE PRODUCTS
IS THE SOLE AND EXCLUSIVE REMEDY PROVIDED TO THE CUSTOMER FOR BREACH OF THIS WARRANTY. TEKTRONIX
AND ITS VENDORS WILL NOT BE LIABLE FOR ANY INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES
IRRESPECTIVE OF WHETHER TEKTRONIX OR THE VENDOR HAS ADVANCE NOTICE OF THE POSSIBILITY OF SUCH
DAMAGES.
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Important safety information

Important safety information

This manual contains information and warnings that must be followed by the user for safe operation and to keep the
product in a safe condition.

To safely perform service on this product, additional information is provided at the end of this section. (See page v,
Service safety summary.)

General safety summary

Use the product only as specified. Review the following safety precautions to avoid injury and prevent damage to this product
or any products connected to it. Carefully read all instructions. Retain these instructions for future reference.

Comply with local and national safety codes.

For correct and safe operation of the product, it is essential that you follow generally accepted safety procedures in addition
to the safety precautions specified in this manual.

The product is designed to be used by trained personnel only.

Only qualified personnel who are aware of the hazards involved should remove the cover for repair, maintenance, or
adjustment.

Before use, always check the product with a known source to be sure it is operating correctly.
This product is not intended for detection of hazardous voltages.
Use personal protective equipment to prevent shock and arc blast injury where hazardous live conductors are exposed.

While using this product, you may need to access other parts of a larger system. Read the safety sections of the other
component manuals for warnings and cautions related to operating the system.

When incorporating this equipment into a system, the safety of that system is the responsibility of the assembler of the system.

To avoid fire or personal injury
Use proper power cord. Use only the power cord specified for this product and certified for the country of use.

Do not use the provided power cord for other products.

Ground the product. This product is grounded through the grounding conductor of the power cord. To avoid electric
shock, the grounding conductor must be connected to earth ground. Before making connections to the input or output
terminals of the product, make sure that the product is properly grounded.

Do not disable the power cord grounding connection.

Power disconnect. The power cord disconnects the product from the power source. See instructions for the location. Do
not position the equipment so that it is difficult to disconnect the power cord; it must remain accessible to the user at all
times to allow for quick disconnection if needed.

Connect and disconnect properly. Do not connect or disconnect probes or test leads while they are connected
to a voltage source.

Observe all terminal ratings. To avoid fire or shock hazard, observe all ratings and markings on the product. Consult
the product manual for further ratings information before making connections to the product.
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Important safety information

Do not apply a potential to any terminal, including the common terminal, that exceeds the maximum rating of that terminal.

The measuring terminals on this product are not rated for connection to mains or Category I, IlI, or IV circuits.

Do not operate without covers. Do not operate this product with covers or panels removed, or with the case open.
Hazardous voltage exposure is possible.

Avoid exposed circuitry. Do not touch exposed connections and components when power is present.

Do not operate with suspected failures. If you suspect that there is damage to this product, have it inspected by
qualified service personnel.

Disable the product if it is damaged. Do not use the product if it is damaged or operates incorrectly. If in doubt about safety of
the product, turn it off and disconnect the power cord. Clearly mark the product to prevent its further operation.

Before use, inspect voltage probes, test leads, and accessories for mechanical damage and replace when damaged.
Examine the exterior of the product before you use it. Look for cracks or missing pieces.

Use only specified replacement parts.
Wear eye protection. Wear eye protection if exposure to high-intensity rays or laser radiation exists.

Do not operate in wet/damp conditions. Be aware that condensation may occur if a unit is moved from a cold to a
warm environment.
Do not operate in an explosive atmosphere.

Keep product surfaces clean and dry. Remove the input signals before you clean the product.

Provide proper ventilation. Refer to the installation instructions in the manual for details on installing the product
so it has proper ventilation.

Slots and openings are provided for ventilation and should never be covered or otherwise obstructed. Do not push objects
into any of the openings.

Provide a safe working environment. Always place the product in a location convenient for viewing the display
and indicators.

Avoid improper or prolonged use of keyboards, pointers, and button pads. Improper or prolonged keyboard or pointer use
may result in serious injury.

Be sure your work area meets applicable ergonomic standards. Consult with an ergonomics professional to avoid stress
injuries.

Use care when lifting and carrying the product. This product is provided with handles for lifting and carrying.

c WARNING. The product is heavy. To reduce the risk of personal injury or damage to the device get help when lifting or
carrying the product.

Use only the Tektronix rackmount hardware specified for this product.
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Important safety information

Service safety summary

The Service safety summary section contains additional information required to safely perform service on the product. Only
qualified personnel should perform service procedures. Read this Service safety summary and the General safety summary
before performing any service procedures.

To avoid electric shock. Do not touch exposed connections.

Do not service alone. Do not perform internal service or adjustments of this product unless another person capable of
rendering first aid and resuscitation is present.

Disconnect power. To avoid electric shock, switch off the product power and disconnect the power cord from the mains
power before removing any covers or panels, or opening the case for servicing.

Use care when servicing with power on. Dangerous voltages or currents may exist in this product. Disconnect
power, remove battery (if applicable), and disconnect test leads before removing protective panels, soldering, or replacing
components.

Verify safety after repair. Always recheck ground continuity and mains dielectric strength after performing a repair.

Terms in this manual

These terms may appear in this manual:

c WARNING. Warning statements identify conditions or practices that could result in injury or loss of life.

c CAUTION. Caution statements identify conditions or practices that could result in damage to this product or other property.

Symbols and terms on the product

These terms may appear on the product:

B DANGER indicates an injury hazard immediately accessible as you read the marking.

®  WARNING indicates an injury hazard not immediately accessible as you read the marking.

B CAUTION indicates a hazard to property including the product.

A When this symbol is marked on the product, be sure to consult the manual to find out the nature of the
potential hazards and any actions which have to be taken to avoid them. (This symbol may also be used to
refer the user to ratings in the manual.)

The following symbol(s) may appear on the product;

A @ + b

CAUTION Protective Ground .
Refer to Manual ~ (Earth) Terminal Chassis Ground  Standby
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Compliance information

Compliance information

This section lists the EMC (electromagnetic compliance), safety, and environmental standards with which the instrument
complies.

EMC compliance
EC Declaration of Conformity - EMC

Meets intent of Directive 2004/108/EC for Electromagnetic Compatibility. Compliance was demonstrated to the following
specifications as listed in the Official Journal of the European Communities:

vi

EN 61326-1 2006, EN 61326-2-1 2006. EMC requirements for electrical equipment for measurement, control, and
laboratory use. 123

CISPR 11:2003. Radiated and conducted emissions, Group 1, Class A
I[EC 61000-4-2:2001. Electrostatic discharge immunity

|EC 61000-4-3:2002. RF electromagnetic field immunity

IEC 61000-4-4:2004. Electrical fast transient / burst immunity

IEC 61000-4-5:2001. Power line surge immunity

IEC 61000-4-6:2003. Conducted RF immunity &

IEC 61000-4-11:2004. Voltage dips and interruptions immunity 4, 7

EN 61000-3-2:2006. AC power line harmonic emissions

EN 61000-3-3:1995. Voltage changes, fluctuations, and flicker

European contact.

Tektronix UK, Ltd.
Western Peninsula
Western Road
Bracknell, RG12 1RF
United Kingdom

This product is intended for use in nonresidential areas only. Use in residential areas may cause electromagnetic interference.
Emissions which exceed the levels required by this standard may occur when this equipment is connected to a test object.
For compliance with the EMC standards listed here, high quality shielded interface cables should be used.

At the IEC 61000-4-11 Voltage-Interruption Transient Immunity test at 0% for 250 cycles, the EUT reboots and can take greater
than 10 seconds to recover.

Performance degradation information for the IEC 61000-4-3 test: Residual spurious signals can typically increase to -55 dBm with
exposure to the disturbance levels of this test.

Performance degradation information for the IEC 61000-4-6 test: Residual spurious signals can typically increase to the worse of
either 55 dB below reference level or -75 dBm, with exposure to the disturbance levels of this test.

Performance Criterion C applied at the 70%/25 cycle Voltage-Dip and the 0%/250 cycle Voltage-Interruption test levels (IEC
61000-4-11).

RSA5100A Series Quick Start User Manual



Compliance information

Australia / New Zealand Declaration of Conformity - EMC
Complies with the EMC provision of the Radiocommunications Act per the following standard, in accordance with ACMA:

®  CISPR 11:2003. Radiated and Conducted Emissions, Group 1, Class A, in accordance with EN 61326-1:2006 and
EN 61326-2-1:2006.

Australia / New Zealand contact.

Baker & McKenzie

Level 27, AMP Centre

50 Bridge Street

Sydney NSW 2000, Australia

Safety compliance

This section lists the safety standards with which the product complies and other safety compliance information.

EU declaration of conformity — low voltage
Compliance was demonstrated to the following specification as listed in the Official Journal of the European Union:
Low Voltage Directive 2006/95/EC.

m EN61010-1. Safety Requirements for Electrical Equipment for Measurement, Control, and Laboratory Use — Part
1: General Requirements.

U.S. nationally recognized testing laboratory listing

m UL 61010-1. Safety Requirements for Electrical Equipment for Measurement, Control, and Laboratory Use — Part
1: General Requirements.

Canadian certification

B CAN/CSA-C22.2 No. 61010-1. Safety Requirements for Electrical Equipment for Measurement, Control, and Laboratory
Use — Part 1: General Requirements.

Additional compliances

® |[EC61010-1. Safety Requirements for Electrical Equipment for Measurement, Control, and Laboratory Use — Part
1: General Requirements.

Equipment type

Test and measuring equipment.

Safety class

Class 1 - grounded product.
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Compliance information

Pollution degree descriptions

A measure of the contaminants that could occur in the environment around and within a product. Typically the internal
environment inside a product is considered to be the same as the external. Products should be used only in the environment
for which they are rated.

m  Pollution degree 1. No pollution or only dry, nonconductive pollution occurs. Products in this category are generally
encapsulated, hermetically sealed, or located in clean rooms.

B Pollution degree 2. Normally only dry, nonconductive pollution occurs. Occasionally a temporary conductivity that is
caused by condensation must be expected. This location is a typical office/home environment. Temporary condensation
occurs only when the product is out of service.

m Pollution degree 3. Conductive pollution, or dry, nonconductive pollution that becomes conductive due to condensation.
These are sheltered locations where neither temperature nor humidity is controlled. The area is protected from direct
sunshine, rain, or direct wind.

B Pollution degree 4. Pollution that generates persistent conductivity through conductive dust, rain, or snow. Typical
outdoor locations.

Pollution degree rating
Pollution degree 2 (as defined in IEC 61010-1). Rated for indoor, dry location use only.

Measurement and overvoltage category descriptions

Measurement terminals on this product may be rated for measuring mains voltages from one or more of the following
categories (see specific ratings marked on the product and in the manual).

B Category II. Circuits directly connected to the building wiring at utilization points (socket outlets and similar points).
= Category lll. In the building wiring and distribution system.

m  Category IV. At the source of the electrical supply to the building.

NOTE. Only mains power supply circuits have an overvoltage category rating. Only measurement circuits have a
measurement category rating. Other circuits within the product do not have either rating.

Mains overvoltage category rating

Overvoltage category Il (as defined in IEC 61010-1).
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Compliance information

Environmental considerations

This section provides information about the environmental impact of the product.

Product end-of-life handling

Observe the following guidelines when recycling an instrument or component:

Equipment recycling. Production of this equipment required the extraction and use of natural resources. The equipment
may contain substances that could be harmful to the environment or human health if improperly handled at the product’s
end of life. To avoid release of such substances into the environment and to reduce the use of natural resources, we
encourage you to recycle this product in an appropriate system that will ensure that most of the materials are reused

or recycled appropriately.

This symbol indicates that this product complies with the applicable European Union requirements according
to Directives 2012/19/EU and 2006/66/EC on waste electrical and electronic equipment (WEEE) and
batteries. For information about recycling options, check the Support/Service section of the Tektronix Web
site (www.tektronix.com).

Perchlorate materials. This product contains one or more type CR lithium batteries. According to the state
of California, CR lithium batteries are classified as perchlorate materials and require special handling. See
www.dtsc.ca.gov/hazardouswaste/perchlorate for additional information.

Restriction of hazardous substances

This product is classified as an industrial monitoring and control instrument, and is not required to comply with the substance
restrictions of the recast RoHS Directive 2011/65/EU until July 22, 2017.
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Preface

Preface

This manual describes the installation and basic operation of the RSA5100A Series Real-Time Signal Analyzers. For
more detailed information, see the Help for your instrument.

= RSA5103A
H RSA5106A
m RSA5115A
B RSA5126A

Key Features
The RSA5100A Series is a family of high-performance real-time signal analyzers. Key features include:
®m Digital Phosphor Spectrum analysis, which greatly reduces the amount of time to recognize and identify a fault

B DPX Density triggering (Option 200) to easily capture instabilities, transients and hidden signals that are impossible
for other signal analyzers to catch

B Conventional spectrum analysis controls and functions including fast tuning, markers, phase noise, spurious and
other measurements

®  Easy event-based capture of transient RF signals by triggering on changes in the frequency domain using
Tektronix-exclusive Frequency Mask Triggering

®  Time domain triggering capability: Runt Triggers, Holdoff Trigger, and Time Qualification to all of the instrument triggers
(Option 200)

B Multi-domain displays that provide an intuitive understanding of time-varying RF signals

= Conventional Vector Signal Analysis capability available (Option 21) with modulation analysis for >20 popular modulation
formats

m  Seamless capture of signals in up to 110 MHz spans

X RSA5100A Series Quick Start User Manual



Documentation

Preface

The following documentation is available for your analyzer. The product documentation CD provided contains documents
available at the time of publication. For the most current documentation, refer to the Tektronix Web site.

To read about

Use these documents

Installation and operation
(overviews)

Quick Start User Manual

The quick start user manual contains general information about how to put your instrument
into service and guides to user interface controls. This manual is available in printed
form and as a PDF file.

RSA5100A Series, English, Tektronix part number 071-2838-XX.
RSA5100A Series, Simplified Chinese, Tektronix part number 071-2839-XX.
RSA5100A Series, Japanese, Tektronix part number 071-2840-XX.
RSA5100A Series, Russian, Tektronix part number 071-2841-XX.

In-depth operation and
user interface help

Online help
The online help contains detailed information about how to operate the instrument. The
online help is available as a PDF file.

RSA5100A Series, Tektronix part number 077-1040-XX.

Application examples

Application Examples Manual
This manual provides practical examples of using the analyzer to accomplish tasks. This
manual is available as a PDF file.

RSA6100B and RSA5100A Series, Tektronix part number 071-2834-XX.

Programming commands

Programmer Manual
This manual contains descriptions of programming commands and their use. This manual
is available as a PDF file.

RSA6100B and RSA5100A Series, Tektronix part number 077-0523-XX.

Specifications and
performance verification

Specifications and Performance Verification Manual
This manual contains the instrument specifications and a procedure to check instrument
performance against warranted characteristics. This manual is available as a PDF file.

RSA5100A Series, Tektronix part number 077-0520-XX.

User service

Service Manual

This manual provides a list of replaceable parts, care and maintenance information, and
information for servicing the instrument to the module level. This manual is available
as a PDF file.

RSA5100A Series, Tektronix part number 077-0522-XX.

Data security

Declassification and Security Instructions
This document helps customers with data security concerns to sanitize or remove memory
devices.

RSA6100B and RSA5100A Series, Tektronix part number 077-0521-XX.

RSA5100A Series Quick Start User Manual
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Preface

Software Upgrades

Software option upgrades are available. Software upgrades for options become operational only after you enter a valid
option key for the specific analyzer model and serial number.

To check for upgrades:
1. Use your Web browser to go to www.tektronix.com/software.

2. Enter the product name (for example RSA5106A) to find available software upgrades.

Conventions Used in This Manual

The following icons are used throughout this manual:

Sequence Front panel Connect Network PS2 SVGA USB
Step power power

° DO OO OCE
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Installation

Installation

Before Installation

Unpack the instrument, and check that you received all items listed as Standard Accessories. Optional accessories and
instrument options are also listed in this section. Check the Tektronix Web site (www.tektronix.com) for the most current
information.

Standard Accessories

Your instrument comes with the following accessories: quick start user manual (languages are listed below), product
documentation CD, power cord, BNC-N adapter, USB keyboard, USB mouse, and instrument front cover.

Product Documentation
m  RSA5100A Series Real-Time Signal Analyzers Quick Start User Manual is available in the following languages:
= English, Tektronix part number 071-2838-XX.
= Simplified Chinese, Tektronix part number 071-2839-XX.
= Japanese, Tektronix part number 071-2840-XX.
= Russian, Tektronix part number 071-2841-XX.
B RSA5100A Series Product Documentation CD, Tektronix part number 063-4314-XX.

Power Cords

Your instrument shipped with one of the following power cord options. Power cords for use in North America are UL listed
and CSA certified. Cords for use in areas other than North America are approved by at least one authority acceptable in
the country to which the product is shipped.

International Power Plugs

®  Opt. AO - North America power

= Opt. A1 - Universal EURO power

E  Opt. A2 - United Kingdom power

H  Opt. A3 - Australia power

®  Opt. A4 -240V, North America power
B Opt. A5 - Switzerland power

m  Opt. A6 - Japan power

®  Opt. A10 - China power

®  Opt. A11 - India power

RSA5100A Series Quick Start User Manual 1



Installation

Opt. A12 - Brazil power
Opt. A99 - No power cord

Optional Accessories

You can order the following optional accessories for your instrument. If you ordered one of these, it should be included
with your shipment.

RTPA2A 2013; Real-Time Spectrum Analyzer Probe Adapter; Supports TekConnect probes P7225, P7240, P7260,

P7330, P7313, P7350, P7350SMA, P7380, P7380SMA.

RSAVu 2013; Offline analysis software based on the RSA3000 platform for analysis supporting 3G wireless standards.

065-0852-XX 2013; Additional Removable Hard Drive for use with Opt. 56
(Windows 7 and instrument software pre-installed).

Planar Crown 3.5 mm female connector, Tektronix part number 131-9062-00.

Planar Crown 3.5 mm male connector, Tektronix part number 131-8822-00.

Planar Crown Type N female connector, Tektronix part number 131-4329-00.

Planar Crown SMA female connector, Tektronix part number 131-8689-00.

Transit Case 2013; Tektronix part number 016-1963-00.
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Options

Installation

You can add the following options to your analyzer:

Option 09 - Adds Enhanced Real Time.

Option 10 - Adds AM/FM/PM and Audio Analysis.

Option 11 - Adds Phase Noise and Jitter Measurement.

Option 12 - Adds Settling Time Measurement (Frequency and Phase).

Option 14 - Adds Noise Figure and Gain Measurement.

Option 20 - Adds advanced signal analysis (including pulse measurements).

Option 21 - Adds general-purpose digital modulation analysis.

Option 22 - Adds flexible OFDM analysis.

Option 23 - Adds WLAN 802.11a/b/g/j/p analysis.

Option 24 - Adds WLAN 802.11n analysis.

Option 25 - Adds WLAN 802.11ac analysis.

Option 26 - Adds APCO P25 measurement application.

Option 27 - Adds Bluetooth® LE and Bluetooth® Basic Rate RF transmitter measurements.
Option 28 - Adds LTE™ Downlink (Base Station) RF transmitter measurements (includes Cell ID).
Option 40 - Adds 40 MHz real-time capture bandwidth.

Option 85 - Adds 85 MHz real-time capture bandwidth.

Option 110 - Adds 110 MHz real-time capture bandwidth.

Option 50 - Adds 1 MHz to 3/6.2 GHz Pre-Amplifier (RSA5103A/RSA5106A only).

Option 51 - Adds 1 MHz to 15/26.5 GHz Pre-Amplifier (RSA5115A/RSA5126A only).
Option 52 - Adds frequency mask triggering.

Option 53 - Adds Memory, 4 GB Acquisition Memory Total.

Option 55 - Adds digital 1Q output.

Option 56 - Removable hard disk drive (not compatible with Option 57 or Option 59).
Option 57 - Internal hard disk drive and CD-R/W drive (not compatible with Option 56).
Option 59 - Internal hard disk drive (not compatible with Option 56).

Option 200 - Adds Advanced DPX with Density, Time Qualified and Runt Triggers and Zero-Span.

Option 5040 - Combines Option 50 (Preamp) and Option 40 (40 MHz Acquisition BW). Mutually exclusive with Options
50 and 40 (RSA5103A/RSA5106A only).

Option 5085 - Combines Option 50 (Preamp) and Option 85 (85 MHz Acquisition BW). Mutually exclusive with Options
50 and 85 (RSA5103A/RSA5106A only).

Option 50110 - Combines Option 50 (Preamp) and Option 110 (110 MHz Acquisition BW). Mutually exclusive with
Options 50 and 110. (RSA5103A/RSA5106A only).
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Installation

m  Option MAP- Adds mapping capability.
B RSA56KR - Rackmount for RSA5100A/B Series, SPECMON/B Series, and RSA6100B Series analyzers.

Operating Considerations

Power supply requirements

Source voltage and frequency Power consumption
100 - 240 Vgrys, 50/60 Hz 450 W maximum (all models)
115 VRMS, 400 Hz

Environmental requirements

Characteristic Description

Operating temperature +10 °C to +40 °C

Non-operating temperature -20 °C to +60 °C

Humidity 90% up to 30 °C (non-condensing)

80% relative humidity maximum when accessing the DVD drive
Above 30 °C it is limited by maximum wet-bulb temperature 29 °C

Altitude:
Operating Up to 3000 m (9843 ft)
Non-operating 12190 m (40,000 ft)
Cooling clearance
Bottom 20 mm (0.79 in)
Sides and back 50 mm (1.97 in)
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CAUTION. To ensure proper cooling, do not operate the instrument on its side. Operate the instrument only when it is resting

on its feet, located on the bottom of the case. Maintain at least 2 inches (5 cm.) clearance around ventilation openings.

WARNING. To avoid personal injury, take extra care when lifting or moving the signal analyzer. The instrument is heavy and

requires extra care when moving it.

Connecting to the Instrument

Connecting to a Network

Connect your keyboard, mouse, printer, and other accessories to your instrument before applying power. (Accessories with

USB connectors can be connected before or after applying power.)

You can connect your instrument to a ‘
network for printing, file sharing, Internet

access, and other functions. Consult your
network administrator and use the standard
Windows utilities to configure the instrument
for your network.

Quick Tip

2838016

= [f you connect your instrument to a network, you should protect your instrument by using an internet firewall, installing

regular approved operating system updates, and using up-to-date antivirus software.

RSA5100A Series Quick Start User Manual
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Installation

Powering On the Instrument
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Removing the Power
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Installation

Operating System Restore

RSA5115A and RSA5126A instruments contain an operating system restore file on a separate partition of the hard drive.
RSA5103A and RSA5106A Series instruments ship with operating system restore disks (DVDs). For these instruments, use
the operating system restore DVDs to restore the operating system should it become necessary.

If the operating system on an RSA5115A or RSA5126A need to be restored, use the following method to restore the
instrument operating system.

c CAUTION. Using the restore process reformats the hard drive and reinstalls the operating system. All saved data is lost. If
possible, save important files to external media before performing a system restore.

1. Restart the instrument. During the boot-up process you will see the following message at the top of the screen: Starting
Acronis Loader... press F5 for Acronis Startup Recovery Manager

2. Repeatedly press the F5 key until the Acronis True Image Tool opens. There is a 5-second time period from when the
message appears until the instrument proceeds with the normal instrument startup. If the instrument does not open the
Acronis application, power off the instrument, then power on the instrument and try again.

3. Click Restore.

4. In the Confirmation dialog box, click Yes to restore the instrument operating system, or No to exit the restore process.
The restore process takes approximately 30 minutes; the actual time depends on the instrument configuration.

RSA5100A Series Quick Start User Manual 7
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Adding an External Monitor

Use the following procedure to add an external monitor for dual monitor configuration. Both the analyzer and the second
monitor must have the color set to True Color.

1. Power off the analyzer and the external (
monitor.

ﬁ

2838018

2. Connect the external monitor to the

analyzer.
[eLe @ §
T ]
L /J—LQ
\ J

2838020

3. Power on the analyzer and the external
monitor.

fan)
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4. Open the Windows Control Panel.

5. Double-click Intel(R) Graphics and
Media to open the Intel Graphics and
Media Control Panel.

6. Set the Display setting to Built-in
Display.

RSA5100A Series Quick Start User Manual
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Adjust your computer’s settings

¥ Action Center

b Backup and Restore

[E Credential Manager

[ Desktop Gadgets

B8 Display

Folder Options

o HomeGroup

Internet Options

F Mouse

& Parental Controls

[ Phone and Modem

B Realtek HD Audio Manager

#5 RemoteApp and Desktop Connections
@) Sync Center

[ Troubleshooting

-]

dows Defender

Nindows Update

() [+ Control Panel + All Control Panel tems »

Administrative Tools

B BitLocker Drive Encryption
2 Date and Time
& Device Manager
@ Ease of Access Center
A Fonts
& Indexing Options
@2 Keyboard
5= Network and Sharing Center
M Performance Information and Tools
3B Power Options
il Recavery
% Sound

ystem
8 User Accounts

&

Yindows Firewall

'\‘1”

Viewby: Smallicons ¥

=g AutoPlay

Ed Color Management

@ Default Programs

# Devices and Printers

FM Elo Touchscreen (32-bit)

5] Getting Started

B Intel(R) Graphics and Media
EZ Location and Other Sensors
2 Notification Area Icons

&l personalization

[ Programs and Features

# Region and Language

& Speech Recognition

ke Taskbar and Start Menu
B

8 Windows Mobility Center

dows CardSpace

| Display

(intel.
Intel®

Graphics and Media
Control Panel

General Settings
Multiple Displays
Color Enhancement
Custom Resolutions

Monitor / TV Settings

Options and Support

e

Color Depth

Refresh Rate

Scaling

Built-in Display

1024 x 768

32 Bit

Scale Full Screen
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Installation

7. Click Multiple Displays.

8. Set the Operating Mode to Clone

Displays or Extended Displays as PR Uy

preferred . Graphics and Media Operating Mode | Clone Displays -
Control Panel
Single Display l:l

| Primary Display
Display E - .
—— EE o Dispiay + Clone Displays

General Settings

Multiple Displays (13 Extended Desktop l:i:l

Color Enhancement
Custom Resolutions

Monitor / TV Settings

Options and Support

9. If you select Extended Desktop, be sure
to set the Positioning to align the two
desktop displays. Intel®

Graphics and Media Operating Mode  Extended Desktop
Control Panel

Primary Display  Built-in Display
| Display g"
——— Second Display ~ Monitor

General Settings

Multiple Displays

Multiple Displays L Positioning.
Color Enhancement
Custom Resolutions

Monitor / TV Settings

Options and Support
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Adjusting the Windows Display Settings

Installation

To change the instrument display settings, use the Intel Graphics Driver instead of the default Windows display properties.
The Intel Graphics Driver provides additional capabilities that are not accessible from the Windows display properties

dialog box.

1. Open the Windows Control Panel.

2. Double-click Intel(R) Graphics and
Media to open the Intel Graphics and
Media Control Panel.

3. Adjust the settings as necessary.

[E=8 Ho

P
(&) [E3 v Control Panel » All Control Panel Ttems »

Adjust your computer’s settings

¥ Action Center %1 Administrative Tools

W Backup and Restore B BitLocker Drive Encryption
[E Credential Manager Y Date and Time
[ Desktop Gadgets

& Display

5 Device Manager
@ Ease of Access Center
E! Folder Options 4 Fonts

& HomeGroup &3 Indexing Options
€] Internet Options €2 Keyboard
F Mouse & Network and Sharing Center
& Parental Controls
{E Phone and Modem 3B Power Options
B Realtek HD Audio Manager £ Recovery
3 RemoteApp and Desktop Connections & Sound
@® Sync Center 18 System
8 Troubleshooting 82, User Accounts
B Windows Defender B Windows Firewall

EJ Windows Update

B Performance Information and Tools

~ [ 4 ||| Search Controt Pane 3

Viewby: Smallicons ¥

g AutoPlay
O Color Management

@ Default Programs

% Devices and Printers

fM Elo Touchscreen (32-bit)

5 Getting Started

B Intel(R) Graphics and Media
[ Location and Other Sensors
2 Notification AreaIcons

B personalization

[E0 Programs and Features
 Region and Language

& Speech Recognition

| Taskbar and Start Menu
B Windows CardSpace

[ Windows Mobility Center

NOTE. Not all of the selections in the
property page will be available if there is no

external monitor connected to the instrument.

4. Click OK to apply the settings and to
close the properties page.

—

intel.

Intel®
Graphics and Media Display
Control Panel

| Resolution
Display

Color Depth
General Settings

Multiple Displays Refresh Rate
‘Color Enhancement
Custom Resolutions Scaling

Monitor / TV Settings

Options and Support

Built-in Display

1024 x 768

32 Bit

B0 Hz

Scale Full Screen

NOTE. Although it is not recommended, you can aftach a second monitor after the analyzer is powered on; however, after
connecting, you will still need to enable the Extended Desktop from the Intel Extreme Graphics 2M control panel.

RSA5100A Series Quick Start User Manual
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Installation

Inspecting the Instrument

Run the diagnostics application (Tools > Diagnostics). If failures occur, perform the following steps to get more information
about them. You can also use the following steps as a detailed incoming inspection to verify the functionality of your
instrument. If you want to check the accuracy specifications of your instrument, see the RSA5100A Series Real-Time
Signal Analyzers Specifications and Performance Verification Technical Reference manual PDF (Tektronix part number
077-0520-XX) located on the Product Documentation CD.

1. Select Tools > Diagnostics. [Tools | Window  Help
= Mask Test...
Alignments
’ Diagnostics } @
Install Upgrades...
Options
RSA Map
3224013
2. On the Diagnostics tab, click All s 9 4
Modules, All Tests. U S U
. Diagnost :s ‘Puwerfon Self Tests | Di Failure Info |
3. Click Single Test. S i e —e—
4. Click RUN. A oo seree
i . 71 Reference Oscillator ]
The instrument will run through the gD e
tests one at a time. A check mark 2 R Time: 4:01 P
or Xicon will appear to the right == e
of each check box as that test is o R N
completed. The check icon means o Do UntilFail
the test was passed. The X means M SR i
the test was failed. 2 S @ ® single Test
5. For tests that require manual SRS
intervention, follow the on-screen

2838067

instructions to complete the tests.

NOTE. Select the Diagnostics Failure Information tab to see basic diagnostic failure information. Use the Windows Event
Viewer (Control Panel > System and Security > Administrative Tools > Event Viewer) to view failure history and nondiagnostic
failures reported by the application.
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Installation

User Maintenance
Caring for the Planar Crown RF Input Connector (RSA5115A/RSA5126A Only)

The Planar Crown input connector consists of two parts. The first part is the Planar Bulkhead, which is mounted in the
instrument front panel. The second part of the input connector is the Planar Crown, which mates to the Planar Bulkhead. The
Planar Crown can be easily changed should the connector become damaged or a different connector type be required.

No tools are required to remove or install the Planar Crown connector. A reasonable hand tightening of the connector is
sufficient to ensure an excellent connection.

When changing connectors, be careful not to touch inner surfaces of the connector halves.

Use only a 75% isopropyl alcohol solution to clean the Planar Crown connector, if needed. Do not use tap water to clean the
connector. Do not submerge the connector in a cleaning solution. Do not use abrasive compounds to clean the connector.

Cleaning Your Instrument

Clean the exterior surfaces of the chassis with a dry lint-free cloth or a soft-bristle brush. If any dirt remains, use a cloth or
swab dipped in a 75% isopropyl alcohol solution. Use a swab to clean narrow spaces around controls and connectors. Do
not use abrasive compounds on any part of the instrument because they might damage the instrument.

CAUTION. Avoid getting moisture inside the instrument during exterior cleaning; use just enough moisture to dampen the

A cloth or swab. Do not wash the front-panel On/Standby switch. Cover the switch while washing the instrument. Use only
deionized or distilled water when cleaning. Use a 75% isopropy! alcohol solution as a cleanser and rinse with deionized
or distilled water. Do not use chemical cleaning agents; they might damage the chassis. Avoid chemicals that contain
benzene, toluene, xylene, acetone, or similar solvents.

CAUTION. To prevent damage to the flat panel display, do not use improper cleaning agents or methods. Avoid using
abrasive cleaners or commercial glass cleaners to clean the display surface. Avoid spraying liquids directly on the display
surface. Avoid scrubbing the display with excessive force.

Clean the display surface by gently rubbing the display with a clean-room wipe. If the display is very dirty, moisten the wipe
with distilled water or a 75% isopropyl alcohol solution and gently rub the display surface. Avoid using excess force; this
might damage the display surface.

Upgrading the Instrument Software

Software upgrades are available from Tektronix. They can either be downloaded from the Tektronix Web site or they can be
ordered from your local Tektronix representative. To add additional software options or features, you will need an option key
from Tektronix. When you receive the software from Tektronix, install it on your instrument. When prompted, enter the option
key, and then follow the online instructions to complete the upgrade.

Returning Your Instrument

If you return your instrument to Tektronix:

RSA5100A Series Quick Start User Manual 13



Installation

Back up any user software on the hard disk. You may need to reinstall the software after your instrument is returned.

®  When repacking the instrument for shipment, use the original packaging. If the packaging is unavailable or unfit for use,
contact your local Tektronix representative to obtain new packaging.

B Seal the shipping carton with an industrial stapler or strapping tape.
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Operation

Getting Acquainted with Your Instrument

Controls and display elements are shown in the following illustrations and tables.

Front Panel Controls

Most front panel controls are shortcuts for opening control panels.

©

Operation

|
I Teq\b f'ﬁuir; @
el- " Yer
| o)
Ref number Item Description Menu equivalent
1 Media DVD£RW drive, removable hard disk drive, or removable
solid-state hard drive.
2 Displays Opens the Displays dialog box to select measurement Setup > Displays
displays.
3 Settings Opens the Settings control panel for the selected display. Setup > Settings
4 Trigger Opens the Trigger control panel. Setup > Trigger
5 Acquire Opens the Acquire control panel. Setup > Acquire
6 Analysis Opens the Analysis control panel. Setup > Analysis
7 Freq Adjusts the measurement frequency. Setup > Analysis >
Frequency tab 2
8 Span (Spectrum) Adjusts the span or frequency range shown in the Spectrum Setup > Settings >
display. ! Freq & Span! 2
9 Amplitude Adjusts the reference level. Setup >
Amplitude 2

RSA5100A Series Quick Start User Manual
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Operation

Ref number Item Description Menu equivalent
10 BW (Spectrum) Adjust the resolution bandwidth (RBW). 1 Setup > Settings >
BWtab1 2

1 Applicable only when the selected display is Spectrum, DPX Spectrum, or Spectrogram.
2 Press and hold for one second to open the associated control panel.

2838-006

Ref number Item Description Menu equivalent
12 Run (Stop) Push to start and stop acquisitions. Run > Run
13 Markers, Peak Moves the active marker to the maximum peak of the trace
in the selected display. If markers are turned off, the MR
(marker reference) marker will appear at the maximum peak.
14 Markers, Select Selects the next marker.
15 Markers, Define Opens the Markers control panel.
17 Control knob Increments/decrements numbers with fine resolution.
18 Arrow keys Move the Markers. The Up arrow moves the selected
marker 10 trace points to the right. The down arrow moves
the selected marker 10 trace points to the left. The left and
right arrows move the selected marker to the next peak.
(Turning the knob moves the marker one trace point left or
right.)
19 Increment / Increments or decrements numbers with coarse resolution.
decrement keys
20 Markers, Delete Deletes the highest-numbered marker.
21 Markers, Add Adds a marker to the selected trace.
22 Replay Replays the current acquisition record.
23 Single Sets the Run mode to Single Sequence and initiates a single

sequence acquisition cycle.

16
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Bksp
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2838009

Ref number Item Description Menu equivalent
24 Keypad Enters values in controls.
25 Enter Completes the data entry in controls. Same as pressing the

Enter key on the keyboard.

) @) (-
@ =

2838-002

Ref number Item Description Menu equivalent

26 Recall Opens the Recall dialog box. File > Recall

27 Save Saves working file using the same user selections as for the File > Save
previous Save action.

28 Touch Screen Off Turns the touch screen on and off.
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Ref number Item Description Menu equivalent
29 Help Displays the online help. Help >
User Manual
31 Application Opens the Application preset dialog box. You can change Presets >
the effect of pressing Application using the settings at Application
Presets > Preset Options > Preset type/action.
32 DPX For instruments with Option 200, opens a DPX display set Presets > DPX

to the same span as the Spectrum display. If the Spectrum
display is not open, the span is set to the last span of the
Spectrum display. Without Option 200, the maximum span
of the DPX display is limited to the maximum acquisition
bandwidth of the instrument. You can change the effect of
pressing DPX using the settings at Presets > Preset Options
> Preset type/action.

33 User Opens the User preset dialog box. You can change the Presets > User
effect of pressing User using the settings at Presets > Preset
Options > Preset type/action.

34 Preset Resets the instrument to its factory default settings. You can Presets > Main
change the effect of pressing Preset using the settings at
Presets > Preset Options > Preset type/action.
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Front Panel Connectors
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Ref number Item Description
1 Trig Out Trigger output connector. 50 Q, BNC, High>2.0V, Low < 0.4 V, (output current 1 mA)
2 Trig In External Trigger input connector, 2.5 V to +2.5 V range,
trigger level is user adjustable
3 USB port USB 2.0 connector
USB port USB 2.0 connector
RF Input RF input connector 50 Q
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Rear Panel

. el
O @3

=
GIOMRO, =

Ref number

13) (14 -

0519047

Connector, Description

AC Input, main power connector

2 GPIB

4,5 Real Time 1Q Out (Option 05)

6 +28 VDC output, switched

7 Microphone in; Headphone, audio output; and Line In connectors
8 External Trigger 2 Input

9 COM 2, serial port for connecting peripherals

10 VGA external monitor output (resolution not limited to VGA)

1" PS2 Keyboard input

12 USB 2.0 ports for mouse and other peripherals (printers, external hard disks)
13 Ref Out, reference frequency output

14 Ref In, reference frequency input

15 LAN, Ethernet network connector

20
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Interface and Display Elements

Operation

Commonly-used buttons and controls are located in the tool bar. Most of the buttons open control panels for changing the
instrument setups. The contents of the control panels vary depending on the selected display. You can also access the
control panels from the front panel buttons or from the keyboard.

00000000 ® GO @

@ File

d View \Run | Refl Mirkers” Seap  Presets  Togls  Window  Help g X
| B9 2 & T & & 1A | Frequency: 1.85000 GHz  Reflew: -11.00 dBm Prset Repla ) Stop .
v 7 Trace 1 vIShow Avg (VRMS) Avg Clear
o dB/div:

10.0 d8
o RBW:
1.00 MHz

P

M1: -137.58 dBm/Hz
AM1:9.35

IntPwrM1: -13.61 dBm

PwrDenM1: -83.32 dBm/Hz

MHz

VBW:

-20.0 -

-60.0 -

-80.0 -

-100.0 -
Autoscale | © CF: 1.5000 GHz

Markers Define v MR

Frequency v |1.849575 GHz

© Span: 110.0 MHz

Peak | [« | [*]|[#][#] [ Tabe | X

To Center

Stopped Not calibrated Real Time  Free Run Ref: Int Atten: 10 dB
Ref Setting Description
number
1 Displays the Open window in order to recall setup files, acquisition data files,
or trace files.
2 ne Opens the Save As dialog in order to save setup files, pictures (screen
ID' captures), acquisition data files, or export measurement settings or acquisition
data.
3 Undo / Redo Undoes or redoes the previous edit to a display or measurement settings, a
preset, or a measurement change.
4 Displays Opens the Select Displays dialog box so that you can select measurement
displays.
Markers Opens or closes the Marker toolbar at the bottom of the window.
Settings Opens the Settings control panel for the selected display. Each display has

its own control panel.

RSA5100A Series Quick Start User Manual
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Ref Setting Description

number

7 Trigger Opens the Trigger control panel so that you can define the trigger settings.

8 Acquire Opens the Acquire control panel so that you can define the acquisition settings.
9 Analysis Opens the Analysis control panel so that you can define the analysis settings

such as frequency, analysis time, and units.

10 Amplitude Opens the Amplitude control panel so that you can define the Reference Level,
configure internal attenuation, and enable/disable the (optional) Preamplifier.

1 Frequency Displays the frequency at which measurements are made. For spectrum
displays, this is called “Center Frequency”. To change the value, click the
text and use the front panel knob to dial in a frequency. You can also enter
a frequency with the front panel keypad or use the front panel up and down
buttons.

12 Reference Level Displays the reference level. To change the value, click the text and enter a
number from the keypad or use the front panel up and down buttons.

13

Recalls the Main preset.
Preset

14 Replay Runs a new measurement cycle on the last acquisition data record using any
new settings.

15 Run / Stop Starts and stops data acquisitions. When the instrument is acquiring data, the
button label has green lettering. When stopped, the label has black lettering.
You can specify the run conditions in the Run menu. For example, if you
select Single Sequence in the Run menu, when you click the Run button,
the instrument will run a single measurement cycle and stop. If you select
Continuous, the instrument will run continuously until you stop the acquisitions.

16 Check mark indicator The check mark indicator ( ‘f) in the upper, left-hand corner of the display

indicates the display for which the acquisition hardware is optimized.

NOTE. The Preset condition for RF and IF optimization is “Best for multiple
displays”. This sets the RF and IF settings to the best compromise of settings
for good results in multiple measurement windows. When other RF/IF
optimizations (maximize dynamic range, fastest sweep, minimize noise) are
chosen, a check box will appear on the selected display that is receiving
optimized settings for that measurement. Normally, the check box is not
present, as the “Best for multiple displays” condition is selected.

17 Show Shows / hides the selected trace.
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Operation

Display-Specific Controls

Most displays have commonly-used controls arranged around the graph. They provide quick access to common settings;
the full control set for the display is in the Settings control panel. The following illustration and table show some of the
common icons that appear in most displays.

@ @

File  Wiew| Run Replay Markers | Setup  Tools  Window  Help 5 x
B o) & T % 5 TR Frequency: 244700GHz  Reflev: 0.00 dBm Preset | B Replay - | 2 Run
¥ Tracel  [¥IShow Sample MNormal \@|

£ 3.3000 MHz

= Position:
-200.00 kHz

()

-3.7000 MHz

il r
[Autoscdle | o position: 99,795 ws © Scale: £21.820 us

Settling Time: 200.50 us Settled Freq: 2.445307 GHe
from Trigger: 196.93 us
2838-024

Table 1: Common icons

Ref number Control icon Description
1 w Drop-down List. Click to select a value from the drop-down list.
2 ] Knob. Click anywhere on the icon or on the text readout to select the control. You

can then change the value with the front panel control knob or arrow keys, or enter a
value from the keypad.

3 6.337us ltalicized numbers. These indicate automatically selected control values. Several
controls in the instrument (for example, RBW and Analysis Length) allow you to
select an Auto mode. In Auto mode, the instrument software automatically sets the
value. You can change the control to Manual mode by changing the value. To return
to Auto mode, clear the value, and then press the Enter key.
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Basic

24

Concepts

Real Time Analyzers

Your Tektronix real-time analyzer has an optional frequency mask trigger. The frequency mask trigger allows you to set up a
spectral mask to capture a signal when a spectral anomaly occurs. This allows the real-time signal analyzer to check 100%
of the input signal before acquiring, and then capture precisely the intermittent RF event of interest.

DPX™ technology allows you to view the RF signal as a live display. You can view very short transient signals, multilevel
signals, and time-varying events. Option 200 includes the ability to measure and trigger on signal density values in the

DPX display.

The RSA5100A Series Real-Time Signal Analyzer allows you to view the captured signals in a wide variety of time-correlated
displays. This is useful for device troubleshooting and signal characterization applications. All of the measurements, other
than the DPX display, are based on the same underlying set of time domain sample data.

Measurement Displays

The analyzer window can show one or any combination of general purpose and application-specific displays.

This example shows a DPX Spectrum Split
display (Option 200 required). A DPXogram
display appears on the top and a DPX
Spectrum display appears on the bottom.

File  View Run Replay Markers Setup Tools Window Help = 4
B & @ T % & 1R Frequency: 15000 6Hz Reflev: 0.00 dBm sl | @ Replay = | ) Run
Replay: Acq Data AR D Select All Select.. §# 1 10/24/2011 23:17:4.59

o Time/div:
2.50s
3D

o Pos:
0.0 div

© 0.00 dBm

o dB/div:
10.0 dB

o RBW:
500 kHz

Split. -
-100.00 dBm
Autoscale & CF: 1.5000 GHz o Span: 85.0 MHz
Stopped Mot aligned Real Time Free Run Ref: Int Atten: 15 dB

Spectrums/line: 1

. T® =

v DPXogram [¥]Show +Peak Clear
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This example shows the window with two
displays, a Spectrum display and a DPX

spectrum display.

When you have more than one display
open, the display with the check mark icon
has control over the acquisition hardware.
To give a display priority over any others,

click its title bar.

This example shows four displays in the

window.

Operati

on

File View Run Replay Markers Setup Tools Window Help
S] & @ T & & % Frequency: 10000000 GHz  Reflev: 0.00 dBm

Preset

Repla O Stop

DPX Spectrum

v Btmep  [¥Ishow on Clear

= [@][=

© 0,00 dBm

» dB/div:
10.0 dB

o RBW:
1.00 Ktz

-100.00 d8m —

[ Autoscale | © CF: 1.0000000 GHz © Span: 100.0 kHz

Spectrum
~ Trace1 [@show +Peak Normal
0,00 dBm
o dB/dn:
10.0 dB
o RBW:
1.00 kt#z
VBW:

[Autoscale | = CF: 1.0000000 GHz

e
Al
il W

© Span: 100.0 kHz

Tranfer Acq BW: 156.25 kHz, Acq Length: 2.501ms  Real Time Free Run
— T T — T

Ref: Int_Atten: 25 dB

File View Run Replay Markers Setup Tools Window Help

B & & T & % {7 | Frequency: 10000000 GHz  Reflev: 0.00 dBm Freset Repla D stop
[ Amplitude vs Time = =[5 oPx Spectrum = B ==

v Trel [

© -3.95 dBm
o dB/dw:
10.0 dB

o Span:
100.0 kHz

-103.95 dBm

[ Autoscale | L
AMS: -10.64d8m ¢ POStion: -1.116 ms
Max: 5.82dBm @ <08.6us  Min: ~45.18dBm @ 102.4us

© Saale: 2.232 ms

w Btmap  [@show On

-100.00 dBm
| Autoscale | ¢ CF: 1.0000000 GHz

[ clear |

© Span: 100.0 kz

B spectrogram o= ][=
| ce

o Tmejdiv:
111 ms

o RBW:
1.00 kHz
vBw:

3D

o Pos:
0.0 dv

1.0000

Span: 100.0 kHz

[ Autoseale | =

Spectrum
¥ Tacel [¥Show +Peak Normal
0,00 d8m
o dB/di:
10.0 8
o RBW:
1,00 ktz
VBW:

-100.00 dBm (| |
[Autoscale | = CF: 1.0000000 GHz

= @)=

[ Clear |

© Span: 100.0 khz

Transfer Acq BW: 156.25 kHz, Acq Length: 2.606 ms  Real Time  Free Run
= T T T

Ref: Int Atten: 25 dB

The acquisition data source can be a live acquisition or a saved acquisition data file. The sharing of acquisition data between
displays allows you to view the same data in multiple ways. For example, you can display a power versus frequency
(spectrum) display and a spectrogram diagram at the same time. Because the data source is shared among the different
displays, the displays are correlated. That is, a point or set of points within one display is associated with a point or set of
points in every other display in the application window.
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Navigating Displays

The analyzer uses multiple displays to keep operations simple, and yet provide advanced functionality when needed. Some
of the display categories include:

26

General Signal Viewing displays. These displays show graphs for basic signal parameters such as amplitude, phase,
and frequency plotted against frequency or time. Examples of these displays include: Spectrum, DPX, Spectrogram,
Time Overview, and Phase vs Time.

Analog Modulation. These displays show graphs and measurements for Analog Modulation, Frequency Modulation,
and Phase Modulation.

General Purpose Digital Modulation displays. Available with Option 21, General Purpose Modulation Analysis.
These displays show the results of demodulating signals and analyzing them in multiple domains. Examples of these
displays include: Constellation, EVM vs Time, Eye, Symbol Table, and Trellis diagrams.

RF Measurements displays. These displays show the results of automated measurements on RF signals. Examples of
these displays include: ACPR, MCPR, Phase Noise, and CCDF.

OFDM Analysis. These displays provide OFDM analysis for WLAN 802.11alj/g and WiMax 802.16-2004 signals.

Pulsed RF displays. Available with Option 20, Advanced Signal Analysis. These displays show the results of advanced
analysis for pulsed RF signals. Examples of these displays include: Pulse Statistics, Pulse Table, and Pulse Trace.

Audio Analysis. These displays measure basic time- and frequency-domain parameters of analog audio signals
modulated on a carrier (AM, FM and PM modulation) or unmodulated (non-carrier) audio signals (Direct).

WLAN Analysis. Available with Options 23, 24, and 25. Each of these options provide OFDM analysis of WLAN802.11
standards. All three options combined provide analysis for WLAN802.11a/b/gfj/p/n/ac signals.

APCO P25 Analysis. Available with Option 26. This complete set of push-button Telecommunication Industry
Association TIA-102 standard-based transmitter measurements includes modulation measurements, power
measurements, and timing measurements. These measurements are also compared with the limits that best fit the
signal for which the standard applies to provide pass/fail results.

Bluetooth® LE and Bluetooth® Basic Rate RF. Available with Option 27. Bluetooth LE (Low Energy) and Bluetooth
Basic Rate RF (Radio Frequency) provides 13 transmitter performance measurements for 10 different test setups in
compliance with Bluetooth RF PHY Test Specifications 4.1.1 and Radio Frequency (RF) Test Specifications 4.1.1.

LTE™ Downlink Analysis. Available with Option 28. LTE Downlink (Base Station) RF analysis provides transmitter
performance measurements for both TDD and FDD (for example, Channel Power, Occupied Bandwidth, ACLR,
SEM, Cell ID, and TDD LTE Transmit Power Off) in compliance with Test Specifications 36.104 (Base Station radio
transmission and reception) and 36.141 (Base Station conformance testing).

Noise Figure. Available with Option 14. These displays measure the noise contributions in a system. Displays include
Noise Figure, Gain, Y-factor, Noise Temperature, Uncertainty Calculator, and tabular results. Single-frequency metering
and swept-trace results are available, as well as support for industry-standard noise sources. Measurements for amplifiers
and other non-frequency converting devices, and fixed local-oscillator up and down converters are also available.
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Selecting Displays

The analyzer provides an easy way to select displays.

1.

Click the Displays icon to open
the Select Displays dialog box.

Operation

View  Run

File

5% & T % 2 I | Frequency: 150000 GHz

@

Replay ~ Markers

Setup  Tools Window Help
Reflev: 0.00 dBm

Fresel | b Replay

- 8 x

- | 2 Run
2838011

There are two ways to select displays: choose any combination of displays or use an Application Preset.

Choose any Combination of Displays. Select displays one by one as needed.

@ @

1.

Click the desired application folder
in the Select Displays dialog box.
The available displays for each
folder are listed in the Available
Displays pane.

Click one of the display icons.

Click Add (or double-click the
icon) to add the selected display
to the Selected displays list.
Repeat the procedure to add other
displays.

Click OK to close the dialog box.
The selected displays will open.
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Choose any combinatio|| below, or use an Applicati|n Preset. Application Presets...

Folders:

Available displays:

General Signal Viewind) |8 AMPL 7 FREQ
Analog Modulation Vau 1 N, —~
GP Digital Modulati
RF M;gasme:ml;tslon =|| | Amplitude vs DPX Frequency  Phase vs
OFDM Analysis i Time vs Time Time
Pulsed RF |3
P25 Analysis
Audio Analysis 52

RFI&Q vs Spectrogram  Time

Time Qverview
Selected displays:
Spectrum
oK Cancel

@

m2838-081

®
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Use an Application Preset. Select displays from the presets for your application.

1. Click Application Presets in the Select

Displays dialog box.

2. Use the pull down list to display the
presets.

NOTE. Some presets appear only if the
associated instrument option is installed.

3. Select a preset from the list.

Choose any combination below, or use an Application Preset. l Application Presets... l

Measurements: Available displays:

General Signal Viewing I8

Amplitude vs DPX Frequency  Phase vs
Time vs Time Time

Analog Modulation
GP Digital Modulation
RF Measurements
OFDM Analysis

m

Audio Analysis -

Bluetooth Analysis M
P25 Analysis .

Pulsed RF RFI&Q vs  Spectrum Time
WLAN Analysis 2 Time Overview

Selected displays:

0

Spectrogram

Remove

o] (o]

3359001

Preset: Spectrum Analysis ,"—.
Moise Figure

Time-Frequency Analysis

Si ectrum Anaisis |
Modulation Analysis ‘

Preset displays:

J’ _L Pulse Analysis
Spur Search Multi Zone 9k-1GHz
Phase Noise
Spectrum

To go directly to a preset in the future, use Tools->0ptions-=Presets->Preset action

oK ] ’ Cancel

3224015
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4. The default displays for the selected
preset are shown.

5. Click OK to close the dialog box. The
preset displays will open. (See Table 2.)

Table 2: Application presets

Presets

Operation

m Application Presets

Preset: [Modulation Analysis

Preset displays:

E] W

Constellation  Signal Quality ~ Symbol Table DPX

@

To go directly to a preset in the future, use Tools->Options->Presets->Preset action

Cancel

(5)

Displays

3224004

Modulation Analysis (Option 21 only)

Constellation, DPX Spectrum, Signal Quality, Symbol Table

Pulse Analysis (Option 20 only)

DPX Spectrum, Pulse Table, Pulse Trace, Time Overview

Spectrum Analysis

Spectrum

Spur Search Multi Zone 9k-1GHz

Spurious

Time-Frequency Analysis

Frequency vs Time, Spectrogram, Spectrum, Time Overview

Noise Figure (Option 14 only)

Gain, Noise Figure, Noise Table

Phase Noise

Phase Noise
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Use a Standards Preset. When you select a specific standard from the Standards presets, the analyzer automatically
loads the displays and settings that are optimal for analysis of signals based on that standard.

1. Select Presets > Standards from the Presets | Tools  Windo @

main menu bar. Main

DPX
Standards
Application

User

Preset Options

3224019

2. Use the Preset pull down list to display

and select a preset from the list. T = = @
3. The default displays for the selected S P25 ‘

preset are shown. M s E
4. Click OK to close the dialog box. The _ _ :

preset displays will open. (See Table 3.) SEM - Time Overview i
NOTE. Some presets appear only if the
associated instrument option is installed. Stondard:

Bandwidth:

To go directly to a preset in the future, use Tools-=0ptions-=Presets-=Preset action

@ =) (o

3224020

Table 3: Standards presets

Presets Displays

WLAN (Option 25) SEM, Time Overview, WLAN Summary, WLAN Constellation
P25 (Option 26) MCPR, Time Overview, P25 Summary, P25 Constellation
Bluetooth® (Option 27) BT Eye Diagram, BT Frq Dev vs Time, BT Summary, BT CF

Offset and Drift, Spectrum, Time Overview

NOTE. Bluetooth displays vary depending on the selected Test
Setup.

LTE™ (Option 28) LTE Summary, LTE Constellation, Time Overview, Spectrum,
LTE ACLR, LTE Channel Spectrum, SEM

NOTE. LTE displays vary depending on the selected Test Setup.
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Quick Tips
m  Push the Displays button on the front panel to open the Select Displays dialog box.
®  To add a display, double-click the icon.
= To remove displays, do one of the following:
= Select a display icon in the Selected Displays list, and then click Remove.
= Double-click a display icon in the Selected Displays list.
= Click the Close button in the upper right hand corner of the selected display.

= You can mix displays from multiple application folders.

Common Information Messages

The following table lists some of the common information messages that might appear during normal operation.

Table 4: Common information messages

Message Explanation and recommended action

Acq BW too small for current setup The display needs a wider acquisition bandwidth than the current data record
contains. This can be due to any of the following reasons:

m A display other than the one you intended has been selected. The selected
display has requested a smaller acquisition bandwidth to achieve a better
accuracy or dynamic range for its particular measurement.

Select the display that contains the message. Click Run if the instrument
is not already acquiring data.

B Acquisitions are not running and the measurement now requests a wider
bandwidth than the last acquisition.

Click Run to perform a new acquisition with a wider bandwidth.

B The data is from a recalled file.

There is no way to increase the acquisition bandwidth for saved data. You
must adjust the measurement settings so that less bandwidth is required.

Need swept acq or larger Acq BW When any display requires a swept acquisition, the other displays are unable to
process the swept data. This is because the swept data is customized for the
selected display.

Select the display that you are interested in and the acquisition settings will
automatically change to meet the requirements of the selected display.
RBW increased to xx kHz The current Spectrum Length or Analysis Length is not long enough to allow
a narrower RBW filter.

If the Length control is set to Manual, try increasing it or setting it to Auto so
that the Analysis Length will increase to the required value.
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Changing Measurement Settings

The displays have settings that control how signals are acquired and processed. The settings that you can change depend
on the selected display.

To access the settings (in this case, for the Spectrum display):

1.

Click Settings to open the Settings
control panel.

Adjust the controls as needed for your
signal or test. For example, use the
Freq & Span tab to set frequency and
span. Most of the control panels have
tabs that provide easy access to other
related controls.(See page 33, Quick

Tip.)

You can change the appearance of the
display screen in the Prefs tab. Not all
of the following controls apply to every
display. Some displays have additional
controls not described here.

= To turn on or off the graticule, select
the Show graticule check box.

®  To turn on or off the marker readout,
select the Show Marker readout in
graph check box.

= To turn on or off the trace legend,
select the Show trace legend check
box. The trace legend includes
information on the trace number,
detection, and function (such as
average) for each trace on screen.

B To turn on or off the parameter
readouts. select the Show
parameter readouts check box.
This reports the time to create and
display the sweep of the spectrum
analyzer. It includes the entire
sweep plus any retrace time. When
trace averaging is activated, the
sweep reports the time for individual
traces while collecting the averages,
and reports the time for the entire
averaged trace when averaging is
complete.

PH File  Wiew Run  Replsy Markers Setup  Toals
& & T & & [A | Frequency: 190000 GHz

Window  Help -
Reflev: 0,00 dBm Bt | ® Replay - [0 Stop

@

Spectrum
Settings

Restare
Defaults

2838025

Freq & Span | BW | Traces [ Scale [Prefs |

Center:
Start:
Stop:

Step Size:

1,9000 GHz

1.8575 GHz

1.9425 GHz

5.0000 Mz

Span: 85.0 MHz Max Span

Auto

Marker readout
" Trace legend

Parameters readout | #=s

Graticule
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Quick Tip

®m If you have multiple displays on the screen, click anywhere inside one of the other displays to change to the control
panel for that display.

®  You can adjust many of the parameters of your measurement by clicking on the readout in the display. For example,
in the spectrum display, dB/div, RBW, VBW, Span, and Center Frequency can all be accessed on the display without

bringing up the Settings panel.
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Presetting the Instrument

You can preset the instrument to restore the setups to their default values.

1. To start with the default instrument
settings, push the Preset button on the
front panel or select Preset from the
Setup menu.

Quick Tip

| o

<Displays> (Settlngs CRun/Sto@

Freq Acquire ( single )

Span
Ampl

@

D
@@ =
Bksp

(=) (=)

i

Trigger

Arm

2838022

m  Preset does not change any of the settings specified from the Config In/Out control panel or from the Tools menu, such
as GPIB address, Save/Export preferences, or the Auto Alignment setting.

34
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Connecting a Signal

The analyzer has a single RF signal input located on the front panel. Make sure that you observe the input signal
requirements before connecting a signal to the input.

CAUTION. To prevent static damage to the instrument or to any instrument accessories, discharge to ground any

A electrostatic charge that may be present on the center and outer conductors of cables, before attaching the cables to the
instrument inputs. Do not create an ESD (electrical static damage) antenna by leaving cables aftached to the instrument with
the other ends of the cables open.

Required Signal Levels

The following table shows the input signal levels over which the analyzer can be used for measurements. The accuracy is
guaranteed at a signal amplitude and frequency (normalization point). Measurements can be made on signals within the
entire range of allowable inputs, but the accuracy of the measurement is affected by the frequency and amplitude of the
signal to be measured (see the RSA5100A Series datasheet for more information).

RF signal input range (CW or peak envelope power)

Characteristic Description
Maximum DC voltage 15 V (RF input)
Maximum safe input power +30 dBm (RF Input, RF ATT=10dB, Pre-amp Off)

+20 dBm (RF Input, RF ATT=10dB, Pre-amp On)

+50 Watts peak (RF Input, RF ATT=30dB, (<10 us, 1% Duty Cycle
repetitive Pulses))

Maximum measurable input power +30 dBm (RF Input, RF ATT Auto)

+10 Watts peak (RF Input, RF ATT Auto (<10 ps, 1% Duty Cycle
repetitive Pulses))

CAUTION. To prevent damage to the instrument, do not connect CW signals greater than 1 Watt (+30 dBm). The maximum
voltage rating is £5 V DC. The maximum pulse specifications are 50 W peak, <10 us pulse width, 0.001 duty cycle and
230 dB attenuation.
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To connect an RF signal:

= Connect the signal to the RF INPUT [ )
connector on the front panel. -

e
NOTE. On RSA5115A/5126A instruments, oo O %S0
you can change the RF input connector type o 86892
o
(@]

by using a different Planar Crown connector.

Quick Tip

m  |f the source signal exceeds the specified maximum input rating, connect the source signal to an attenuator. Connect the
attenuator output to the RF Input connector.

Starting and Stopping Acquisitions

1. Click the Run button to start an ]
acquisition. oG ]
Window  Help g X
B To select the Run mode, click the Reflev: 000 dEm Prest @ Replay  ~ | ) Run -

drop-list icon to the right of the Run

button.
=R ==

m  Select Single or Continuous to
set the Run mode as necessary.

5 X

Freset | @ Replay =
= Single
) Continuous

If the analyzer is in Continuous

Run mode, the Replay button is L
dimmed while acquisitions are

active. If there are no acquisitions Preset Replay

active, the Replay button is blue.
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2. Click the Stop button again to stop (oo e

an acquisition. If an analysis is in :
process, it will finish its sequence Yindow  help g x
and then stop. Reflew: 0.00 dBrn Preset Replay =) Stap -

Clear

Quick Tip

m  Push the front panel Run button to start and stop acquisitions.

Run Control

The Run menu provides access to commands that control the acquisition and the measurement sequence. Refer to

the online help for information on all of the Run menu selections. Continuous is the default selection. When you select
Continuous, the instrument will continuously acquire data until you stop the acquisitions. Select Single Sequence to run a
single acquisition every time you click Run or push the Run button on the front panel.
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Markers
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Use markers to measure time, frequency, power and other results. Markers measure absolute values and can also measure
the difference between markers.

Using Markers to Measure Frequency and Power

The following procedure shows how to use markers in the Spectrum display to measure frequency and power. The example
assumes that all markers are turned off and that a signal is on the screen.

1.

Click Markers to open the
Marker toolbar at the bottom of
the Analysis window.

Select Add Marker from the
drop-down list on the Marker
Toolbar.

The first marker is designated
the marker reference (MR).

Position the marker on the
screen using the arrow buttons in
the Marker toolbar. You can also
drag the marker to the desired
position using the touch screen
or the mouse.

Read the frequency and power
level from the marker readout on
the display.

File  “iew  Run  Replay  Markers  Setup  Tools  Window  Help

B 5 &

o T 7

Frequency: 190000 GHz ReflLew 0,00

@

Define Markers Marker Properties | Define Peaks‘

283026

8
Reference Delta Markers o
| Add | Marker:
— Attach to:
| Delete | (in selected
—_— display) —
Readouts: |Delta -
[aor | Add Marker ‘ |
Delete Marker }
Markers All markers off | To Center | | Peak | Table || x|
2836007
B Tek RSAS1004 - [Spatmasg] = |2 .
File  View lay | Markers Setup Tools Window Help & x
= @\~ / ¥ IR | Frequency: 1.90000 GHz Reflev: 0.00 dBm Preset Replay Dstep -

< 0,00 dBm
o dBfdiv:
10.0 cb
- REW:
50.0 kiHz
WBW:

-100.00 dBm

| Autoscale | © R 1.50000 GHz
Markers | Define v MR

“ Tragz1  [VIShow +Peak Normal

Frequency +|1.800875 GHz

| Clear ‘

s=pan: 5.00 MHz

To Center ‘ Peak z\ EJ ‘z‘ E‘ I Table HI|

2838028
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Markers Display

You can display up to five markers including the reference marker. Markers can all be placed on the same trace or they can
be placed on different traces. There are three types of Markers:

m  Reference Marker: This marker type is labeled MR in the graph. It makes absolute measurements and is also used for
calculating differences when Delta or Power readouts are enabled.

m Delta Markers: This marker type is labeled M1 to M4 in the graph. It is used to measure other points on the trace or the
difference between the Marker Reference and the Delta marker.

m  Power Markers: This marker type is labeled M1 to M4 in the graph. It function the same way as Delta Markers, except it
shows power density and integrated power density (dBm/Hz) instead of power level (dBm).

The following information tells you more about how markers function. For more detailed information about markers, see
the instrument Help.

m  When you drag markers along a trace with either the touch screen or the mouse, the marker will seek the high points.
The marker stays within 20 trace points of the mouse position. If there are no peaks within the current range of trace
points, the marker finds the highest point.

= When you attach the marker to the bitmap trace in the DPX spectrum display, the marker readout indicates the hit count
for pixels (maximum 65,536) along with frequency and power (see the following figure). You can position the marker
at any point in the graph.

= Ininstruments with Option 200, markers attached to the DPX bitmap display the signal density in percent at the selected
pixel, rather then the hit count.

File  Wiew BRun  Replay  Markers  ZSetup  Tools  Window  Help
B (@@ T % & 1A Frequency: 18000 GHz Reflev: 0.00 dBim

w _ Bitman __ [V|show On

© 0,00 dBm

o dBjdiv:
10,0 de

= RBW:
800 ki

2838054

Quick Tips

B |f markers are turned off, click Peak in the Marker toolbar or on the front panel to add the marker reference (MR) and to
position it on the maximum peak level on the trace in the selected display.

E  Click Table in the Marker toolbar to open a tabular display showing the marker information.
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Marker Toolbar

The Marker toolbar has several controls to work with markers. (See Table 5.) Some of these controls are similar to those
on the front panel.

Table 5: Marker toolbar

Icon Description

Opens the Define Markers control panel. Use the control panel to add and remove markers and
to set marker parameters.

Sets the Measurement Frequency of the instrument to the frequency of the selected marker. This

To Center
button is only present when the selected display has frequency on the horizontal axis.

Peal Moves the marker to the maximum peak level on the trace. The maximum peak can be either the
highest or the lowest point in displays with both positive and negative values on their vertical axis
(such as Frequency Error or Phase).

Moves the selected marker to the next peak to the left of the current position.

Moves the selected marker to the next peak to the right of the current position.

Moves the selected marker to the next lower peak value. The peak value refers to the absolute
value of the peak amplitude. When repeatedly moving the marker, it can move in any direction
depending on the location of the next peak. If the marker is attached to the DPX bitmap trace, this
button moves it to the next-lower-amplitude density peak at the same frequency.

Moves the selected marker to the next higher peak value. The peak value refers to the absolute
value of the peak amplitude. When repeatedly moving the marker, it can move in any direction
depending on the location of the next peak. If the marker is attached to the DPX bitmap trace, this
button moves it to the next-higher-amplitude density peak at the same frequency.

Table Opens or closes the marker table in the display.

I B E|E III

40

Adding Markers

You can have up to five markers. The first marker (MR) is a reference marker. The other markers (M1, M2, M3, and M4) can
show absolute values or can show both absolute values and the difference values between them and the reference marker.

To add another marker, select Add Marker from the drop-down list in the toolbar.

Markers can also be added by right-clicking in the desired display and selecting Add marker.
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Defining Markers

Use the Define Markers control panel to define the marker settings.

1. Click Define to open the Define Markers Makers [Defie ] v MR [Freauency 190010835 GHe F [

control panel. P

Use the COﬂtI’O| panel tO Define Markers Marker Properties | Define Peaks
Reference Delta Markers
®  Add or delete markers. - -
Attach to:
B Turn markers off. e
Readouts:
m  Assign markers to specific traces.
g P Warkers [Define | ~ MR [Frequency - |1.50010825 GHe * ==

®  Set the marker readouts to absolute,
delta, or power.

®  Define the threshold and excursion
values.

Quick Tip

B You can add or delete markers using the drop-down list next to Define in the Marker toolbar, or by right-clicking in the
desired display and selecting Add marker.

Touchscreen Actions

You can use the touchscreen to change marker settings and how waveforms are displayed by using the Touchscreen Actions
menu. To use the Touchscreen Actions menu, touch the display and hold for one second, then remove your finger. You can
also use a mouse to display the Touchscreen Action menu by clicking the right mouse button.

Some selections in the Touchscreen Actions E sclect
menu are selectable only when a marker is
. [l Span Zoom
defined.
++| CFPan
@'\ Zoom
{1:“,? Pan
Reset scale

Marker to peak
Mext peak 3

Add marker
Delete marker

All markers off

Trigger On This

Touchscreen Actions menu
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Table 6: Touchscreen actions menu

Icon

Menu item

Description

Select

Selects markers and adjusts their position.

Span Zoom

Zooms the graph area about the selected point. Touch the graph display at a point
of interest and drag to increase or decrease the span about the point of interest.
Span Zoom adjusts the span control and can affect the acquisition bandwidth.

CF Pan

Adjusts the Center Frequency according to horizontal movement.

Zoom

Adjusts horizontal and vertical scale of the graph. The first direction with
enough movement becomes the primary scale of adjustment. Adjustment in the
secondary direction does not occur until a threshold of 30 pixels of movement is
crossed.

Dragging to the left or down zooms out and displays a smaller waveform
(increases the scale value). Dragging to the right or up zooms in and displays a
larger waveform (decreases the scale value).

Pan

Adjusts horizontal and vertical position of the waveform. The first direction with
enough movement becomes the primary direction of movement. Movement in
the secondary direction does not occur until a threshold of 30 pixels of movement
is crossed.

Reset Scale

Returns the horizontal and vertical scale and position settings to their default
values.

Marker to peak

Moves the selected marker to the highest peak. If no marker is turned on, this
control automatically adds a marker.

Next Peak

Moves the selected marker to the next peak. Choices are Next left, Next right,
Next lower (absolute), and Next higher (absolute).

Add marker

Defines a new marker located at the horizontal center of the graph.

Delete marker

Removes the last added marker.

All markers off

Removes all markers.

Trigger On This

Positions the DPX Density measurement box at the click point, measures the
current signal density, sets up the DPX Density Trigger function based on the
measurement result, and starts acquisitions. (Option 200 required.)
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Printing

You can print a copy of the screen and its contents (a screen shot) to a printer or a file.

1. Push the Print button on the front panel
or select Print from the File menu.

RSA5100A Series Quick Start User Manual
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Recall... Ctrl+O
Save Ctrl+5
Save As...

Save on trigger...
Acquisition save options

FastSave acquisitions...

Acquisition data info

Measurement data info

Print... Ctrl+P

Print Preview

Prezet (Main)
Maore presets

Exit

2838013
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2. Fill out the details in the Print dialog box, Print ==

and then click OK. Piinter

The Print dialog box is the standard Name. [ adobe PDF »] [ Properes.. |

Microsoft Windows Print dialog box. The Status:  Feady

. Type: Adobe POF Converter

pr!nter controls are dependent on your whoe  Dacumertetpd

pl’lnter Comment: [ Print ta file
Frint range Copies
@ Al Mumber of copies: 1 +

Pages &l
ki

(71 Selection 1-2'3 1-2 3 o

Ink Saver Mode

You can print screen images with a white background.

1. Select Options from the Tools menu. Tools | Window  Help
= Mask Test..

Alignments
Diagnostics

Install Upgrades...

Options : @

RSA Map
3224017
2. Select the Colors tab in the control paneL File  View Run Replay Markers Setup  Tools ‘indow  Help LEN
® & T % &[4 | Frequency: 19000 GHz Reflev: 0.00 dBrm Presat Replay Dstop -
3. Set the Color Scheme to Blizzard. v Tace1  [Smow spesk Nomd
0,00 dEm
The background color changes from o g
black to white in the graphs. o REW;
500 ki
] vaw:
-100.00 dEm
© CF: 1,900 GHz © Span: 5.0 MHz
Options ‘Presets |Ana\y5\s Time |Save and Export | GPIB ‘Se\:urity‘ Pref 4@

[7] Markers snap to peaks when dragged

283805
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Saving Data

You can save different types of data for future use.

1. Select Save As. from the File menu to Fie |
open the Save As dialog box. & rel... crl+a

& save ctrl+s
| Save As... I[: ! @

Data properties...

&h Print... Ctrl+P

Print Preview

3 Preset

Application Presets. ..

Exit
1909039
2. Navigate to the folder where you want B 5o =
to save the SetUpS, or use the default EHE0 =]« Defult(C) » RSASL0AFiks @ Sermple Data Records » [ | [ Scarch Sampic Cata Records 9|
location. e s = @
RS& it Name )@ Date modified Type Size ™
] (B WG 4QAM20Mtiq AT/ 1004, TIG File 146
3. Enter afile name. 4 Libraries B wiFiBPSK20M g LAT/2010 338 P TIQ File 14
3 Documents B WifiQPSKSM tig 11/17/2010 5:10 PR TIQ File 14
4. Select the type of file to save. (See o) Music = W] Wi QPSKL0M.tiq LI/ATA2000 417 PR TIG File 14e
& Pictures B WiFiQPSK20Mtig LUAI/200 330 P TIC File 14
Table 7-) B Wideos 9] Wil L6 QARSI tig 11/18/2010 10:19 .., TIQ File 520

(M) Wina6 40020 T/2010 6:20 P s _
. 1% Computer ] iMaxBP KM i /2010 10:37 .. 521
5. Click Save. R \ :
& Defautt (C) [B] WM QPSK2OM 1742010 6:35 PR 52
I WinT_external (B ~ i

File name: -

Save as type: | Acq data with setup (TIQ) (*.tiq) -

Table 7: File types for save
File types Description
Setup files Saves all of the setup information for all settings displays, except those settings that

are specified under the Tools menu (Alignments and Options) or in the Config In/Out
control panel.

Results Export files Saves the trace and numeric data for the selected display. The trace and numeric data
are saved in CSV format as text files.
Picture (PNG/JPG/BMP) Saves a graphical representation of the screen in the specified format. This option is

useful for including the graphic in reports or other applications. Marker readouts and
other information are included.

Selected Trace Saves a trace for later recall back into the display from which it was saved.
Data (acquisition data and Saves data for reanalysis by the analyzer or as CSV (comma-separated value) or MAT
acquisition data export) (Matlab) format to use with external software.

RSA5100A Series Quick Start User Manual 45



Operation

Quick Tips

m  Select File > Save or press the Save button to save the information to a file using the same name, path, and data type
as the last time that you saved. If the file already exists, the file name suffix number will increment if you previously
selected that option in the Tools > Options > Auto Filename control panel tab.

m  Select File > Save As to open the standard Windows Save dialog box where you can edit the file name, choose what
data type to save, and select a folder for storing the file.

Recalling Data

You can recall and reanalyze acquisition data and setup files previously saved by the analyzer.

1. Push the Recall button on the front panel File
or select Recall from the File menu. ]
| Recall... Ctrl+ O I @

B Ssave Ctrl+5
Save As...

Save on trigger...
Acquisition save options

FastSave acquisitions...

“ Acquisition data info

Measurement data info

& Print... Ctrl+P

Print Preview

™ Prezet (Main)

Maore presets »

Exit

2838014
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2. In the Open dialog box, browse to the
location of the file.

3. If you do not see the file, select the type
of file from the drop-down list.

4. Double click the file name to load the file.

Quick Tip

(2)

Operation

Open

=l

@Q* |« Detault(C) » RSAS100AFiles » Sample Data Records »

Organize +

RSA

New folder

i Libraries
[ Documents

o Music

&) Pictures

[EE Videos

B Computer
&, Default (i)

~

34 items

File name:

Narme R
) WIFIBPSK2OM.ti

B WifiQPSKSM tig

) WiiQPSK10M.tig

B WFQPSK2IM.tig

B Wilax1EQAMS I tig
] WittaxE40AMI0M ti
B WikdaPSKSM tig
) WitaxQPSK20M.tig

@

~ [ 42 |[ search sampie Data fecorss |

Date modified

11741772010 3:38 P
11/17/2010 5:10 PM
11/17/2010 4:17 PM
1141772010 3:30 P
11/18/2010 10:19 ...
11/17/2010 6:20 PM
11/18/2010 10:37 ..,
11/17/2010 6:35 PM

m

Type

I File
TIQ File
IO File
I File
TIQ File
IO File
I File
TIQ File

+ | cq data with setup (TIQ) (htic

B - B @

Size

144 KB
144 KB
144 KB
144 KB
520 KB
520 KB
520 KB

SIKE -
r

m

2838061

If you recall a trace that has an x-axis range that does not fall within the x-axis range of the current graph, the trace will not be
visible. A small arrow will point off-screen in the direction of the recalled trace. Use the Frequency and Span (or Span and
Offset) controls to bring the trace on the screen in the Spectrum display. In other displays, use Horizontal Scale and Offset
(which can also be used in the Spectrum display). These controls are on the Settings > Scale tab.
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Advanced Techniques

This section contains advanced operating techniques. For examples of practical applications, see the RSA6100B Series
Real-Time Signal Analyzers and RSA5100A Series Real-Time Signal Analyzers Application Examples Manual.

Setting Up Triggering

The analyzer offers real-time power-level triggers, line trigger, and external triggers. Option 52 adds frequency mask triggers,
and Option 200 includes frequency edge, DPX density, and runt triggering. It uses a trigger event as a reference point in time
for the seamless acquisition of the signal. This allows the analyzer to store both pretrigger and posttrigger information.

The analyzer has two triggering modes:

Free Run mode. In Free run mode, the instrument initiates acquisitions without considering any trigger conditions. It
is a fast and easy way to see the signals. Free Run is usually adequate for the Spectrum display unless you need to
specify a particular time at which to collect the data record.

Triggered mode. In Triggered mode, the instrument initiates an acquisition when a trigger event is recognized. The
conditions that define a trigger event depend on the selected trigger source. There are several source selections available for
choosing the signal to monitor for a trigger event.

Once you select the Triggered mode, you must select the source. The trigger sources are:
®  RF Input

B Trig In

® Trig 2 In

m Gated

E Line

Once you select the trigger source, you can set additional parameters to specify the trigger event. If you specify the RF Input
as the trigger source, you can chose from two trigger types:

DPX Density Triggering. This trigger type enables the instrument to capture any signal you can see in the DPX display,
including difficult to see signals hiding beneath other signals that have a higher amplitude or a greater repetition rate. Using
the Trigger On This™ feature, you can draw a box around the area of interest in the graph, set a Density threshold, and
the instrument will trigger when the measured Density exceeds your threshold.

Time Qualified Triggering. Time Qualified triggers allow you to trigger the instrument based on when signal transitions
occur in time. You can apply time qualification to the basic trigger types. For example, if you select the Power type and
configure it to trigger on a rising edge, Time Qualification allows you to screen rising-edge events based on how long the
signal stays high after it exceeds the trigger threshold. You may wish to trigger only on pulses that last longer than a
specified time or shorter than a specified time. You can set Time Qualified to accept only pulse widths between two specified
values, or outside of these two values.

You can also time qualify Frequency Edge, Frequency Mask, DPX Density, and Runt trigger events. For each trigger type,
the instrument finds all events that meet the basic trigger criteria, then further tests them against your time qualification
parameters.

Frequency Edge Triggering. Frequency Edge triggering triggers the instrument on time-domain signal characteristics.
The incoming data is compared to a user-selected level in Hertz. Frequency edge trigger is similar to Power triggering,
except you also need to set a power threshold to avoid triggering on the apparent frequency fluctuations that occur at low
amplitude. You can select the time-domain bandwidth and trigger on the rising or falling edge.
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Frequency Mask Triggering. Frequency Mask Triggering allows you to trigger the instrument when a signal in the
frequency domain violates the mask. You can draw a mask to define the conditions within the real-time bandwidth that will
generate the trigger event. It allows you to trigger on weak signals in the presence of strong signals. This triggering is
also useful for capturing intermittent signals.

Power Triggering. Power triggering triggers the instrument on time-domain signal characteristics. The incoming data is
compared to a user-selected level in dBm. You can select the time-domain bandwidth and trigger on the rising or falling edge.

Runt Triggering. Runt triggering defines a trigger event based on a pulse amplitude that crosses one threshold but fails
to cross a second threshold before recrossing the first.

In addition to defining the trigger event, you can define the following parameters by selecting the appropriate tab in
the Trigger control panel:

m  Position and Delay parameters that define where a trigger occurs within the acquired data record and whether to
delay the trigger for a set amount of time.

= Whether a single event can trigger an entire sweep, or each segment of the sweep requires a new trigger event in
swept acquisition mode.
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Accessing Trigger Parameters

Click Trig to open the Trigger control
panel.

As shown in the following steps, click
one of the tabs in the Trigger control
panel to define the trigger parameters.

Use the Event tab to set parameters that
define trigger events. The parameters
vary depending on the trigger Source
and Type selections.

Use the Time Qualified tab to set
parameters that qualify trigger events
based on their time duration.

Use the Advanced tab to set parameters
for trigger position and holdoff settings.

Use the Actions tab to set parameters for
the Save on trigger function. The Save
on trigger function allows you to save
an acquisition data file and/or a screen
capture when a trigger event occurs.

File Wiew Run  Replay  Markers Setup  Tools  Window  Help .8 x
® @ T % & 1A Frequency 19000 GHe Reflev: 0,00 dBra Preset Replay D Stop -
2835062
Trigger Event ‘ & Timne Qualified | Advanced | Actions|
Source: Slope Level: [-10.0 0B
@ evel: -10.0 dBm
9 Free Run _RF Input - @ Rise ;/__\
- N T
© Triggered Type: [T] Tirne-darnain Byy:
Force Trigger T
2835063
Trigger t| © Time Qualified | sdvanced | Actions|
_ @
@ Free Run =) B
T —— Time 1 10.000 us
© Triggered © Shorter © Inside I
E e
o — ) Longer ) Dutside r@‘
g [P =B
2838064
Trigger | Event | @ Time Qualified | Advanced | Actions

—

_ [7] Holdaff: 1%
e R Position: 50 % Auto . —
() Triggered F
pelar0s
[ Trigger each segrment of Swept acquisitions

Force Trigger
requires trigger signals across entire Span

|Event | & Time Qualified |Advanced| Actions |

[7] Save acq data on Trigger: TIQ - Max total fies 100

saved per Run:
({1 complete acquisition,
not valid when swept)

|| Save picture on Trigger: PNG -

RSA5100A Series Quick Start User Manual



Operation

Quick Tip
m  Other ways to access the Trigger control panel:
= Push the Trigger button on the front panel.

= Select Trigger. from the Setup menu.

Setting Up a DPX Density Trigger

The DPX Density trigger captures transients partially obscured by other higher-amplitude or more frequent signals. If you
can see it in the DPX bitmap, you can trigger on it. The DPX Density area measurement is used to select the region of
interest in the display and to measure its current density. You set a density threshold, and the instrument triggers when the
density measurement exceeds your threshold.

The quickest way to set up a DPX Density trigger is to use a mouse and right-click on a signal of interest in the DPX
graph, or press on the screen and hold with your finger for one second. A menu will pop up. Select Trigger On This.
This action performs several tasks:

B Places the density measurement box at the click point

®  Sets the measurement box to its default size

B Measures the average density in the box

B Sets the Trigger mode to Triggered

B Selects the DPX Density "Higher" trigger type

m  Adjusts the trigger threshold to a density value slightly below the current measured value
B Starts the acquisition process

To optimize DPX Density trigger settings for your particular signals, open the Trigger control panel. Use the controls for
changing the polarity of the trigger's threshold comparison (Higher versus Lower), the Threshold value, and the size and
location of the measurement box. Use the Frequency and Amplitude settings to locate the center of the box, and set the +/-
values to adjust the width and height of the measurement box.

For events that are partially masked by stronger signals, you will often need to adjust the density Threshold based on
density measurements of the event of interest and of the obscuring signal. For example, if the density of the background
color representing only the stronger signal is 7% and the density measurement including both signals is 9%, you would
set the Threshold to 8%.
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File View Run Replay Markers Setup Tools Window  Help -8 x
& & T & 2 14| Frequency: 205110 GHz Reflev: -20.00 dBm Preset Replay D stop

> Bwmap  [FIshow On

© -20.00 dBm
o defdv:
10.0 dB

Acq BW: 40.00 MHz, Acq Length: 8.660 us Real Time  Free Run Ref: Int_Atten: 10 dB
=

If your expected signal is a continuous tone and you want to capture events when it hops to a different frequency or drops
to a lower amplitude, move the Density measurement box to surround the peak of the signal, select Lower in the Density
control, and set Threshold to 100%. The instrument will trigger when the signal is absent from the measurement box.

Hint. The density measurement is the average of the densities for each column of pixels in the box. If your measurement
box is wider than the peak of a CW signal, the density reading will be less than 100%. To get a 100% reading, you can
broaden the peak by increasing RBW or narrow the box until there are no colored pixels either above or below the box. The
signal should enter the left side of the box and exit the right side. It should not cross the bottom edge of the box.

Creating a Frequency Mask

Use the Mask Editor to create a Frequency Mask. The mask is a set of points defined by frequency and amplitude. Access
the Mask Editor from the Trigger control panel. (This procedure uses the Spectrum display.)

You can create a Frequency Mask by using either the manual or Auto Draw method. The following procedure explains the
manual method. For a procedure on how to use the Auto Draw method, see the topic Mask Editor (Frequency Mask
Trigger) in the online help.

1. Click Trig to open the Trigger control File View Run  Replsy Markers Setup  Tools Window Help & x

pane| [l & & T = & 1 Frequencys 13000 GHz RefLew 0,00 dBr Breset] | O Replay 2 Stop

@

2838062
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@ Free Run SDUL —J T T=F T=FaT Mask Editar
H . RF Input ¥
Click Mask Editor to open the Mask Fo@RT  ORTF [ coaet fiom e |

Triggered

Editor. Type:
' Freauency Mask = T ﬂ ke RBW: S00kE [ Auto
Force Trigger

The Mask Editor opens with the traces of
the Spectrum display in the graph. s

6. Click New in the tool bar. This removes —®

2. Select the Event tab in the control panel. @ @ @ @
3. Set the Source to RF Input.
Trigger Event | & Tinle Qualifie, | Advanced | Actions
4. Setthe Type to Frequency Mask. LEEy
5.

the existing mask and then creates a
default -point mask —
€rault o-point mask. File
Refe G -
Mew ‘ Open ‘ ‘ Save ‘ Save As,.. ‘ ‘ Done ‘ SIrance: | Specmun liace;l |
(to be in list, a trace must be showing in a display)
Click in Add points ] ¥ Margin: 5.000 MHz
araph MNext X Undo
o @ Edlit Paints ¥ Margin: 10,000 8
0,00 dBm
Auto draw
I
'|‘l|ﬂ|| (Offget Freq Amplitude i
phe - i
A ot ‘ ) Al P " 17, 30,
H"’AIW I ’“"‘W“Jl I‘J“l i ‘FI‘ M f "‘“, iy \w | |-17.000mHe 30.00 dem
| ! ||| |J l“ | U \| 8,500 MHz -10.00 dem
' \ 8.500 MHz -10.00 dém E
SO EE 17.000 MHz -30.00 dBm
CF! 1,900 GHz Span: 55.00 MHz 42479 Mhe +30.00 d8m -
2838037
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7. Click any point in the mask to select it. S =
The frequency and amplitude of the il l |
. . . . Reference: |spects Ti 1 -
selected pomt are hlghllghtEd in the I hew ‘ ‘ S [ R ’ S == ‘ (to be in list, a tp:ccerin;strs:eshuw1ng in a display)
graph. Qo O addoans ) ¥ Margin: 5.0 MHz
. . . arap! Mext X Undo
8. Edit the point by doing one of the ti @ Edic Paints - ‘ ¥ Margin: 10,000 ¢
following: DEDEES e » C
g f‘ :j Auto draw
B Drag and drop the point with the |1
mouse. ”
[ Oftyet Freq Amplitude i
= Enter the frequency and amplitude in Tl-’]'\l'w“T" il v w‘ ] ‘\ ‘”'p ‘J"“‘*»“M
-8.500 MHz -10.00 dem
the table 8,500 MHz -10,00 dEm
. . . -100.00 dBm 17.000 MHz -30.00 dBrn
B Adjust amplitude with the Up/dOWﬂ & AETIE s EEDIT 42.479 MHz -30.00 dBm =

arrow keys and frequency with the
left/right arrow keys.

2838038

Quick Tips

m Click Auto draw to generate a mask automatically adjusted to the Reference.
B Right click on the display screen to add a new point.

= Click Add Points and then click on the graph to add a new point in the graph.
= (Click Next to select the next point in the graph.

m  Click the X (delete button) to delete the selected mask point.

m Click Save to save the mask file and continue working with the mask editor.

= Click Open to load and edit a previously saved mask file.

Defining Trigger Conditions

After you have set up the mask, you can select whether to trigger on the presence or absence of mask violations.

1. Select a condition.
The choices are described in the

. , Trigger | Event [ Time Qualfied | Advanced | Acti

following table. (See Table 8.) The icons e

at the bottom of the control panel identify @ Free Run T OTE BT [ asc Ecitor

what is considered true or false. — F @RT  ORTF

B Type:
. . = REW: 00Kz (] But

2. C||Ck Trlggel’ed Farce (Trigger w @True -False H

The instrument will trigger when the )

trigger conditions are met.
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Table 8: Trigger violations

Violation Description

T The instrument triggers whenever the signal violates the mask (above the line).

F The instrument triggers whenever the signal has no points in the mask.

T>F One transition defines the trigger event. The signal must go out of the mask (no violation)
after being inside of the mask (violation).

F>T One transition defines the trigger event. The signal must go into the mask after being

outside of the mask.

T>F>T Two transitions define the trigger event. The signal must start inside of the mask, cross
outside of the mask, and then cross back into the mask.

F>T>F Two transitions define the trigger event. The signal must start outside of the mask (no
violation), cross into the mask, and then cross back outside of the mask.

Controlling Acquisitions

When two or more displays are open, one display controls the acquisition system. The acquisition requirements for the
selected display set the acquisition hardware parameters. While the acquisition parameters are optimized for the selected
display, they might not be ideal for other displays. In this case, the other displays might be unable to maintain optimum
performance and consequently might be unable to produce results. (This also happens when you analyze recalled data:
measurements attempt to deliver results, but may not be able to comply with all their settings.)

You can specify which display controls the hardware acquisition parameters by clicking anywhere in that display. When there
are multiple displays, the highlighted display controls the hardware acquisition parameters.

In this example, there are two displays, a Fe Ve T e Vs s Tos Wi rep
Spectl’um d|Sp|ay and a DPX Spectrum bix“j‘sﬁ T & & 1A | Frequency: 10000000 GHz RefLZ u.a;um}tg i Preset Repla 2 Stop
display. The highlighted title bar on the o D LEEC am |~ e B

Spectrum display indicates that it is the « oo
selected display.
The check mark indicator in the upper
left corner of the display indicates that
acquisition hardware is optimized for the
Spectrum display.

+Peak Nomal

Wl
“\"‘U‘”‘ | \‘\”‘M‘\H“
1 ‘HI i \| |M‘ \U |
-100.00 dBm | ” H !
[Autoscale | © CF: 1.0000000 GHz © Span: 100.0 kHz [(Autoscale | & CF: 1.0000000 GHz © Span: 100.0 kHz

Transfer Acq BW: 156.25 kiz, Acq Length: 2.501 ms  Real Tme Free Run Ref: Int_Atten: 25 dB
= =T I =

Some displays do not control the acquisition hardware. These displays just show the captured data. Some displays share
the same parameters. If any of one of these displays in such a family controls the acquisition hardware, then the acquisition
parameters are optimized for all of the displays in that family.
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Measurements with Conflicting Acquisition Requirements

The analyzer lets you open any combination of measurements. You can select the displays that you are interested in and the
instrument will automatically set up the appropriate analysis and acquisition parameters.

If measurements place conflicting requirements on the acquisition parameters, the current selected display takes priority. The
following example shows incompatible measurement settings when one display needs real-time data (such as the Amplitude
vs Time measurement) while another display requires swept data (such as a Spectrum graph with a very wide span).

1. Push the Preset button on the front —J L
panel to set the instrument to the default
()

settings. O "
2. Tune the instrument to the frequency of (=)
your signal and then set the span. (e
2834-066
3. C||Ck the DiSplayS icon to open the SeleCt File View Run Replay Markers Setup Tools Window Help .8 x
Dlsplays dlalog boxl = & @El’f A 1A | Frequency: 19000 GHz Reflev: 0.00 dBm Fresl | @ Replay = ) Run -
2834002

®

# Selecthe General Signal Viewing (18 s I = i
older.
5 Select the Amplltude vs Time icon Choose a@ination below, or use an Applimnj Preset. I Application Presets... l
6. Click Add to add the icon to the Selected Me““'e"“ e Avaiable dispiays;
. . AMP -
Displays list. Analog Modulation -
GP Digital Modulation =
NOTE. Add the Spectrum display i it is not R Mezsurmens P R P
already in the Selected Displays list. P25 Analysis
Audio Analysis
Pulsed RF M
. WLAN Analysis RF I&Q vs Spectrogram Time
7. Click OK to accept the changes and Noise Figure and Gain Time Overview
close the dialog box.

Selected displays:

Add

Spectrum

3224-016
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8. Increase the span in the Spectrum
display to 200 MHz.

Because Spectrum is the selected
display, the acquisition parameters
adjust automatically to meet the needs
of the display. The 200 MHz span
exceeds the real-time bandwidth of the
instrument. As a result, the instrument
will change to swept mode.

9. Look at the Status bar. The readout
“Swept” indicates when acquisitions are
swept.

When the acquisitions are in “Real Time,
all measurements usually run. If the
acquisitions are swept, only the selected
display can run.

10. Click the Amplitude vs Time display to
make it the active display.

The acquisition switches back to
real-time because the selected display
requires real-time. The data is now
suitable for the Amplitude vs Time
display but doesn't contain the full range
of frequencies needed by the Spectrum
display.

In this case, the Spectrum is unable to
run.
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11. Decrease the span to 25 MHz in the
Spectrum display. Now the acquisitions
are real time again.

12. Check the status bar readout to verify
that the acquisition is real-time.

Both of the displays can run now.

Fle View Run Replay Markers Setup Took Window Help
=] © @ T & &% % | Frequency: 100000GHz  Reflev: 0.00 dBrm B | © Repl O stop
¥ Amplitude vs Time = [ @ | = || Spectrum
v Tmcel [VIShow +Peak Nomal Cear v Tmcel [@IShow +Peak Nomal

©-3.95dBm 5 0.00 dBm

o dgjdv: o dB/dn:

10.0d8 10.0 d8

o span: o RBW:

25.00 Mz DT

vBw:
1l \l i
”\“ hal) h H\H| ‘N‘ “l\“\|| 1 ‘H\“ \”
i
el \f\WH \ ‘I U U il M
Y
il ‘ \I

-103.95 dBm ‘
Autoscale | i
RMS: 6.93d6m @ Position: ~200.000 ns © Saale: 2,020 us -100.00 d8m
Mac 679cBn @ -600ms Mn: 07dm @ Lswus [Autoscale | cF: 1.00000 GHz

Transfer

Acg BW: 40.00 MHz, Acq Length: 52.320 us
T T—T

Real Time _Free Run Ref: Int_Aften: 25 dB

3

@
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Mask Testing

The analyzer lets you test many trace results for changes in level. You can identify matches crossing a power level or
you can create a mask that specifies power level and frequency range limits. You can select which trace to test and
specify an action to take when a test condition is met for traces in the Spectrum, DPX, Noise Figure, Spurious, and Setting
Time displays. The Frequency Settling Time, Phase Settling Time, Spurious, Bluetooth InBand Emission, and Occupied
Bandwidth measurements tests provide pass/fail results.

The available choices include only results from displays that are currently open.

Selecting Mask Test from the Tools menu displays the Mask Test control panel. These settings define test parameters and
specify actions to be performed when the test conditions are met.

To start a mask test. Perform the following steps to set up for any mask test.

1. Open the Spectrum display or select the @
Spectrum display if it is already open. Tools | Window  Help
2. Select Tools > Mask Test. 9 Mask Test.. |
Alignments
Diagnostics

Install Upgrades...

Options
R5A Map
3e24-021
3. Select the Enable Test check box to set MaskTest | Define | Actions]
the application to perform the test once
the conditions are defined. Enable Search n:
Test for: IE outside mask v] [ Edit limits... ] [ Load from file...
@ 32402
4. Select the trace you wish to test from the @
Search in drop-down list box. B e [acsand
Enhl Search in: |Spectrum: Trace 1 v]

Test
Spectrum: Trace 1

Spectrum: Trace 2

Spectrum: Trace 3

Spectrum: Math Trace
Spectrum: Spectrogram Trace

Test for:

‘ -20.00 dBm

3e24-024
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5. Verify that the trace you selected in the
Search in list is the selected trace and
that the Show box is checked.

6. Click the Actions tab to specify what
actions the analyzer should take when a
match occurs.

The analyzer can take up to five actions
when a match occurs, depending on the
run mode. In Run mode, the analyzer
can sound a beep, stop acquisitions,
save acquisition data, save trace data,
and save a picture of the display. In
Replay mode, it can sound a beep and
stop analyzing.

7. To have the analyzer take an action
when a match occurs, select the desired
action.

You can select any combination of
actions to perform on a match. If you
select all actions, they will all occur when
a match is found (in Run mode).

60
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 Trace 1
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) Enable
Search Beep
Stop

‘ Clear ‘

© Span: 100.0 MHz

During Run only

Save acquisition data ‘TIQ -
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To perform a Greater Than/ Less Than mask test.

1. Specify what to test for by making a
selection from the Test for drop-down
list.

To test for signal levels above or below
a specified level, select either is greater
than or is less than.

2. Press the Run button to initiate a test.
Click the Replay button on the toolbar to
initiate a test on the current data record.

3. Notice the vertical red bar. It highlights
results that match the test definition.

4. Click the close box to remove the Mask
Test control panel.
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Mask Test Define | Actions
v BT Search in: ‘S ctrum: T 1 v|
Test : |Spectrum: Trace
Test for: |is greater than - -20.00 dBm
is greater than
is less than
is outside mask b
is inside mask
Transfer Not calibrated weal Time  Frea Run
¥ Tracel [Z]Show +Peak Normal
» dB/div: 0.0 -
10.0 d8
o RBW:

100 ktiz
] vBw:

Data from uncalibrated instrument

-100.0 -

Autoscale | © CF: 1.50000 GHz

Operation

Ref: Int Atten: 30 dt
32425

&)

© Span: 10.00 MHz
324027
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Operation

To perform an Outside/Inside mask test. If you specify a mask-based test, then you need to edit the mask to specify
the levels that define a violation. You can do this as follows.

1. Select is outside mask or is inside mask from the Test for menu.

2. Click the Edit limits button to display the Mask Test Editor window.

il Mask Test Editor - Mask1 © e S S o S =R
FEile
Reference: |spect T s
‘ New ‘ ‘ Open ‘ ‘ Save ‘ Save As... ‘ ‘ Done ‘ | pectnim Trace
(to be in list, a trace must be showing in a disg

Click in Add points X Margin: 0.000 Hz
araph Next X indo
to: @ Edit Points ¥ Margin: 20.000 dBm

ey Auto draw
Enable
| Upper Mask
Upper Mask Table - V| Lower Mask
Offset Freq Amplitude

| I
||
||
-100.00 dBm I
Offset:  1.50000 GHz Scale:  40.00 MHz i

3. Click the New button to create a table. This clears the existing points and loads the default table. You can also click
Open to open an existing table.

4. To edit values, add points, or delete points in a table:

a. To edit an existing value, double-click on the cell you want to edit and enter the desired value. The active point
shows as a red point on the plot.

Reference: |Spectrum Ti = =
‘ New ‘ ‘ Open ‘ ‘ Save ‘ Save As... ‘ ‘ Done ‘ | pectium Trace |
(to be in list, a trace must be showing in a display)
Click in Add points X Margin: 5.000 MHz
araph ‘ MNext ‘ ‘ X ‘ ‘ Undo )
to: @ Edit Points ¥ Margin: 10.000 dBm

0.00 dBm u o u A
u Enable
V| Upper Mask
Upper Mask Table - Lower Mask
Offset Freq Amplitude o
-16.000 MHz -5.00 dBm
-5.00 dBm
8.000 MHz -5.00 dBm E
-100.00 dBm 16.000 MHz -5.00 dBm
Offset: 0 Hz Scale:  40.00 MHz 20.000 MHz -10.0 dBm s
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b. To add a new point, check the box next to the target mask (located below the Auto draw button).
c. Select Add points located below the Open button.
d. Select the target mask (Upper Mask Table or Lower Mask Table) from the drop-down menu.

e. Click in the desired location on the plot to add the point.

Reference: -
‘ Mew ‘ ‘ Open ‘ ‘ Save ‘ Save As... ‘ ‘ Done ‘ |S|Jectrum diecer |
(to be in list, a trace must be showing in a display)
Clickin @ Add points . X Margin: 5.000 MHz
graph MNext X Undo
to: Edit Points ‘ ‘ ‘ ‘ ‘ + ¥ Margin: 10.000 dBm
0.00 dBm \i‘ — \i‘ Auto draw
u Enable

| Upper Mask

Upper Mask Table - Lower Mask

Qffset Freq Amplitude i
-3.508 MHz -5.36 dBm
s e |asan |
8.000 MHz -5.00 dBm |
ST B 16.000 MHz -5.00 dBm [
Offset: O Hz Scale:  40.00 MHz 20.000 MHz -10.0 dBm -

f. To use the auto draw feature to automatically place points on the chosen mask, enable the desired mask from the
drop-down menu and then click the Auto draw button.

Reference: |Spectrum Trace 1 ‘|
(to be in list, 3 trace must be showing in a disply)

Cickin @ Add points — 1 ] X Margin: 5.000 MHz
araph Next X Undo )
to: Edit Points Y Margin: 10.000 dBm

‘ Mew H Open H Save ‘

Save As... ‘ ‘ Done ‘

Enable
Upper Mask
Upper Mask Table ~ V| Lower Mask
Qffset Freq Amplitude i
15.350 MHz 20.1 dBm
15.400 MHz 20.4 dBm
19.700 MHz 19.0 dBm
-100.00 dBm 19.750 MHz 214 dBm
Offset: 0 Hz Scale:  40.00 MHz 20.000 MHz 21.4 dBm i

NOTE. Units may be changed for measurements other than Noise Figure in Setup > Analysis > Units.

5. To delete a point from the table, select the point to be removed, and click the X button.
6. To save the mask to a file for later recall, click Save As.

7. From the Save As dialog, name the file and save it in the desired location.
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NOTE. Masks are saved in XML format with a .msk extension.

8. To dismiss the Mask Test Editor window, click Done.

Mask Test result examples. The following figure shows the results of a Spectrum is outside mask test with Upper Mask
enabled. The vertical red bar highlights results that have exceeded the test limits. The shaded region shows the mask area.

= Trace 1 ¥|Show +Peak Normal

Clear
o dBfdw: 0.0 -
10.0 dB
o RBW/:
100 kHz
VBW: 2=

-60.0 -

Data from uncalibrated instrument

-100.0 -

Autoscale | © CF: 1.50000 GHz

= Span: 10.00 MHz

The following figure shows the results of a passing Noise Figure is outside mask test with Upper Mask enabled. Markers
are also in use.

< v Trace 1 V| Show Mormal Clear
© 2008y igzam 11:2.26 d8
o fly 225 i a5t mas
A m
200 mdB 875 MHz
M1
o Position:
2.00 dB
R
© 1.00 d8
| Autoscale © Pos: 2.5000 GHz © Scale: 1.0 GHz
Max: 23d8 @ 2958GHz Min: 15d8 @ 2.083GHz Mean: 2.0d8
Markers | Define ‘ v MR Frequency |2 GHz To Cente Peak \ﬂ m \L‘ \ﬂ Table X
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The following figure shows the results of a failing Noise Figure is outside mask test with Lower Mask and Upper Mask
enabled. The red area highlights the area of failure, which occurs at the lower mask. Markers are also in use.

s ¥ Tracel [¥Ishow Normal
© 29308 ygorssas
o Jdw 2GHz
1.00 98
R
o Position:
24.308
v 19308
© Pos: 2.5000 GHz © Scale: 1.0 GHz
Max 27.5d8 @ 2000GHz Min: 2L1d5 @ 3.000GHz Mean: 25.9d8
Markers [ Define | w M1 [Frequency - 875 iz To Center [« [*] [*]
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Using Correction Tables

The analyzer lets you correct the signal displays and measurement results to account for gains and losses in external
equipment. You can specify a single gain value or you can use an external loss table to adjust the gain/loss value based

on frequency.

To specify external gain/loss corrections:

1. Press the Amplitude icon button to
display the Amplitude control panel. @

PH File  Wiew Run  FReplay Markers Setup  Tools  Window Help 5 x

2. Select the External Gain/Loss =] & & T = % 18] Frequency: 190000GHz  Reflew 0,00 dBm BRw | O Replay O stop -
Correction tab v Trace 1 [Z]Show +Peak Normal ‘C\EE

© 0,00 dBm

o dBfdiv:
10.0d8

o RBW:
200 kHz
WEW!

-100.00 dBm
| Autoscale | o CF: 190000 GHz

© Span: 25.00 MHz

Amplituce Internal Settings | Extermal Gain/Loss Corection | External Probe Carrection ‘ ‘

External Loss Tables (Loss » 0, Gain < 0)

External Gain value: 0.0 dB

Ext Loss Table 1 | Edit.. |
Apply external corrections to:
All acquired data (filtter method) Ext Loss Table 2 | Edit... ‘
o P L TS Ext Loss Table 3 [CEde. |
2838047
3. To apply a constant correction factor,
select the External Gain value check
box. Enter a value into the text entry box. arplitude Intern|| Settings | External GainjLoss Corection | Extemal Frobe Correction
NOTE. You can enter either positive or 7] Extermd Gan vdus: 0.0 0B Extemal Loss Tabes (Loss > 0, Gan < 0)
X . . Ext Loss Table 1 | Edt.. |
negative gain values. Positive values Apply external comections to; — =
) : 3 it Loss Table Edit...
represent a gain. Negative values represent e ats e et
a IOSS (see Lser r\?apnua\ fior Iis’i) i Ext Loss Table 3 \L‘
2838042
4. To use a table that corrects for gain/loss
values depending on frequency, click a
check box under External Loss Tables. Amplitude [ mternal Settlﬂgs‘ External GainfLoss Correction | Extern:| Probe Correction |
You can enable all three external loss e os & Extemal Loss Tables (Loss > 0, Gun < 0)

i e 5] bl [ Edit...
tableg at the same time. Thus, you could P S — B Bxtloss Tk 1 (pat.]
use different external loss tables for an a0l accuired data (fiter method) O [Ext Loss Table 2 [Ledt. |
antenna, a preamplifier, and for cabling. g ol [ Bt Loss 120 3 [ .. |

5. To edit the contents of an external loss 2000

table, click the Edit button for the table
you want to edit.
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6. Edit the contents of the table to match
the loss characteristics of the equipment
you are correcting for. Click OK when
you are finished.

NOTE. You can enter either positive or
negative values into the table. But in contrast
to the External Gain value setting, positive
values represent a loss and negative values
represent a gain.

For detailed information on using the Table
Editor, select Help > User Manual and look
in the Index for External Loss Tables.

7. You can change the title for each external
loss table. Select the title box and type
in a new title.

Note that the title is only a label. It is
not tied to the file name of any table you
have loaded or saved.

8. Specify whether table corrections are
applied to all acquired data or only to
traces in the Spectrum, Spectrogram,
Spurious and Amplitude vs Time
displays.

Corrections applied to data are
performed in real time using the digital
filter capabilities of the instrument. While
this has the advantage of correcting
the data for use in all measurements,
digital filtering is limited in its ability to
apply corrections that change rapidly in
amplitude over small frequency ranges,
as may occur when switching between
two antennas. When this happens,
the filters may result in an amplitude
correction that appears to ring in its
response, resulting in poorly corrected
data. For that reason, the RSA offers
trace-only correction for spectrograms,
spectrum, spurious, and amplitude vs.
time displays. These trace corrections
are similar to those applied in traditional
spectrum analyzers, and should be
used when discontinuities occur in the
amplitude/frequency correction table.

RSA5100A Series Quick Start User Manual

Operation

o Table Editor - ExtLoss Table 1 =8 EoR =<
‘ add Point ‘ Dilete Undo X Freguency Y Loss (Atten)
914,0000 MHz -2.000000 dB
-1.019000 dB
0.0000000 o
Frequency Interpolation
@ Linear 9260000 MHz -2.000000 dB
Log (affects only
Trace Correction)
Mew Table | Load... | Save As... | ‘ Apply ‘ ‘ Ok ‘ | Cancel |
File ‘iew Run Replsy Markers Setup Tools Window Help & x
=] & & T % N [[A Frequency: Lo00006Hz  Reflew: 0.00 dBm Bres) | O Reply O step -
v Trace 1 J]show +Peak Normal |Clear |
© 0.00 dBm
o dBfdiv:
10.0 dB
= RBW:
200 itz
WBW:
-100.00 dBrn
| Autoscale & CF: 1.90000 GHz o Span; 25.00 MHz
Amplitude Intermal Settings ‘ External GainjLoss Correction ‘Extmnal Probe Carrection ’ |
‘ ‘ : 0B External Loss Tables (Loss » 0, Gain < 0) @
External Gain value: 0.
[¥]  Antenna Edit.
Apply external corrections to:
All acquired data (filter method) ¥ Preamp \L}
5 Tracesin applicable displays 7 .
@ (see User Manual for list) ‘ Cahing \Ed#]

@ 2838044
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When choosing whether to correct
sample data or traces, keep the following
in mind:

If sample data is acquired while

data correction is enabled, that data
record is permanently corrected. If the
acquisition is saved and recalled, the
recalled acquisition includes corrections.
Corrections are not saved separately
from the raw data; they are used during
the acquisition process to adjust the data
values.

Trace corrections can be applied

at any time, as they are part of the
measurement's computations. Using
Replay will apply trace corrections to
a trace if this control is enabled (and
an external loss table is specified and
enabled).

Be aware that if you recall acquisition
data that was saved with data corrections
and you use Replay with trace
corrections selected and an external
loss table enabled, the trace will be
calculated using corrected data and also
corrected with trace corrections. This
usually creates incorrect traces.

. Click the close box to remove the

Amplitude control panel when you are
finished making changes.
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Using Audio Demodulation

Operation

The analyzer can demodulate AM and FM signals, which can help you to identify unknown radio signals. You access the
Audio Demod tab from the Settings control panel of the DPX Spectrum plot display.

To demodulate an audio signal:

1. Press the Displays button to display the
Select Displays dialog box.

2. Select the General Signal Viewing
folder.

3. Double-click the DPX Spectrum icon to
add it to the Selected Displays list.

4. Click OK to close the dialog box. The
DPX display will open.

5. If necessary, select the Spectrum plot
from the drop-down list.

6. Press the Settings front-panel button to
display the DPX Settings control panel.

7. Click the Audio Demod tab to display
the Audio Demod control panel.
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®

Choose any|combination below, or use an Applicatipn Preset. Application Presets...

Measuremer|ts:

Available displays:

General Signal Viewing | AMPL —m FREQ.
Analog Modulation T Ve | Ny
GP Digital Modulation
RF Megasurements Amplitude vs  [I24 Frequency  Phase vs
OFDM Analysis = Time vs Time Time
Audio Analysis ey
Bluetooth Analysis W
P25 Analysis B L
Pulsed RF RFI&Q vs Spectrogram  Time
WLAN Analysis 7 Time Qverview
Selected displays:
Spectrum
Remove
oK Cancel
3369002
[ File View 24n Replay Markers Sctup  Prescts  Tools Window Help g8 x
® (@[] T = % 17| Frequency: 488,20 MHz RefLewi 0.00 dBm Bt | @ Replay - |DFRun -
~  Bitmap  [VIshow Fle:DPX Pulsed Clear
© 0,00 dBm
« dBfdiv:
10.0d8
o RBW:
100 Ktz

DP¥ Settings

Spectrurn
-100.00 dBm
Autoscale © Pos: 488,28 MHz © Scale: 10.00 MHz

| Freq & Span [ Bw [ Traces | Horiz & vert Scale | Bitmap Scale [ Prefs | Density | Audio Demod

Plot:

Spectrurm -

Restore
Defaults

Audio

Gain™®
off
(]

* Sound level is also affected by Windows volurne contral

AM

T

El

Tune with: Maker MR+

Recelver Freg;  488.2 MHz

Receiver Byy; #0000 kHz

32408
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8. Click the On button to enable audio
demodulation.

9. To specify the demodulation type, click
either the AM or FM button.

NOTE. Note that the AM and FM buttons
select only the demodulation type; they do
not specify a frequency band.

10. Set the center frequency as needed.

The receiver frequency (frequency to

be demodulated) is specified with either
markers or the frequency control (the
front panel Frequency button or the Freq
control in the toolbar). Use the Tune with
setting to specify whether markers or the
frequency control is used to specify the
receiver frequency.

11. Select either a marker or frequency
control from the Tune with drop-down
list.

12. If the marker you select is not enabled
(it will be visible in the display if it is
enabled), click the Markers iconMarkers
button in the toolbar to display the
Markers toolbar.

8

| Freq & Seln | Bw | Traces | Horie & vert Scale | Bitmap Scale | Prefs | Density | Audio Demod

: Tune with; [Selected Marker~
Plot: rU” "
{Spectrum vI Audio 91.5 MHz
Gain™
Off Fi

A =

Restore

Defaults

* Sound lelvel is also affected by Windows volume control,

DPY Settings

Receiver Freq:

Bl

Receiver Byy: 30.000 kHe

©

DPYX Settings | Fred & Epanl B I Traces | Hariz & Wert Scalel Bitrnap Scale | Prefs | Density ‘ Audio Demad
Plot: Tune with: __Selected Marker I
— on AM l Marker MR
IEpectrum vJ Audio Nomoiuon Dran iopleg il _J
Gain'™ - Marker M2
Off Fr " . Markar M3
o Recaivar BW: Marker M4
gg?‘ga‘r& * Sound level is also affectad by Windaws viFreq control
2836-046
[[1 File Viel: Run Replay Markers Setup  Presets  Tools Window Help 8 x
5] T & %% T Frequency: 48620MHz  Reflew 0.00 dBm @ oy - DR -
~  Bitmap  [VIShow Fie:DPX Pulsed Clear
© 0,00 dBm
o dBfdiv:
100dB
= RBW:
100 KHiz

Spectrum - I '

-100.00 dBm
Autoscale © Pos: 488,28 MHz

DP¥ Settings

© Scale: 10.00 MHz

‘ Freq & Span | B | Traces I Horiz & Vert Scale I Bitmap Scale |Drefs |Densitv‘ Audio Demnod ‘

Tune with: Maker bR =)

483,275 MHz

e -
e — on
Spectrum - Audio

Gain™®
Restore
Defaults

Receiver Freq:

off

0

Receiver Bwy;  20.000 kHe

* Sound level is also affected by Windows volurme control.

3553008
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13. Click the Define button in the Marker
toolbar to display the Define Markers
control panel.

14. Click Add to add markers as needed.

15. Click the Settings button to return to the
Audio Demod control panel.

16. Set the required receiver bandwidth by
entering a value into the Receiver BW
value entry box.
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Marker Properties | Define Peaks

Define k| arkers

&)

Reference Delta Markers
Add Marker: MR
Attach to: Tracel -
Delete {in selected
display)

Readouts: | Delta -
ToCenter | | Pesk | |# EJ

Al off
Markers [_Deﬁnﬂ w MR

1)
15

[T\ File View |Run Replay Markers Setup Presets Tools Window Help a x
® T % & IR | Frequency: 488.20 MHz

o Bitmnap

[time  -Jeasosm

&

Reflev 0,00 dBm Presetl | @ Replay

+ | % Run -

[gear

[¥]Show File:DPX Pulsed

Spectrurn v

-100.00 dBm
Autoscale 9

Define Markers Marker Properties | Define Peaks
Reference Delta Markers
Add Marker:
Attach to:
Delete (in selected
display)
Readouts: | Delta -
all off

Markers w aloff |Frequency To Center Peak Table || %

DPYX Settings | Freq & Span| Bw | Traces | Horiz & vert Scale | Bitmap Scale [ Prefs | Density | Audio Demod |

Tune with; |Marker MR -

91.5 MHz

On ‘
Audio

Gain*
el !
=

* Sound level is also affected by wWindows volure cojitrol,

16)

Receiver Freaq:

Receiver Byy;  30-000 kHz

o =
. ]

Restore
Defaults
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17. Set the receiver frequency.

18.

If you specified a marker with the Tune
with setting, drag the marker to the
required frequency. Fine tune the marker
position with the front-panel knob or
your mouse wheel. If you selected
Frequency control in the Tune with
setting, press the front-panel FREQ
button, then turn the front-panel knob or
use the Freq setting in the toolbar to set
the required frequency.

The receiver frequency is displayed as
Receiver Freq between the Tune with
and Receiver BW settings.

Adjust the Audio Gain setting so you can
hear the demodulated signal. Note that
the sound level is also affected by the
setting of the Windows volume control.

[Tl File View Run Replay Markers Setup Presets Tools Window Help 5 x
=] Trf’\'l:'\. Frequency: 488.20 MHz Reflev: 0,00 dBm Presctl | @ Replay = ) Run -

v Bitmap  [V1Show File:DPX Pulsed Clear
= 0.00 dBrn
« dBfdiv:

10.0 dB
o RBW:
100 k7

Spectrum = = |

-100.00 dBm
Autoscale < Pos: 488.28 MHz

COPX Settings

© Scale: 10,00 MHz

| Frem & Span| B | Traces | Horiz & vert Scae | Bitmap Scale | prefs | Denswt;tr] Audio Demod |

Tune with: |Marker MR -

Receiver Freq:  488.2 MHz

Gain*
s
=
[ Restore |
Defaults /18\
Markers [ Define | ~ MR 4BE‘ZMHZ

Reriver Byy:  1.000 ki

* Sound hevel is also affected by Windows volume control,

To Center E B EJ EJ Table E
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power cords, 1
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standard, 1
Acquisition
conflicts, 56
controlling, 55
data source, 25
starting, 36
stopping, 36
Analysis window, 24, 26
Application presets, 28
audio demodulation, 69

C
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Touchscreen actions menu, 41
check mark indicator, 22, 55
Cleaning procedures, 13
Conflicts

measurement, 56
Connectors

front panel, 19

rear panel, 20

RF signal input, 35, 36
Controlling acquisitions, 55
Controls

display-specific, 23

front panel, 15

interface, 21
Cooling clearances, 4
correction tables, 66

D

Data

recalling, 46

saving, 45
Default settings, 34
Diagnostics, 12
Digital demodulation displays, 26
Display

conflicts, 56
Display properties

changing, 11
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Display settings
changing, 32
Displays
general signal viewing, 26
GP digital modulation, 26
printing, 43
Pulsed RF, 26
RF measurement, 26
selecting, 27
Documentation, xi
Tektronix part numbers, 1
DPX Density
triggering, 48

E

Environmental specifications, 4
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cooling clearances, 4
humidity, 4
temperature, 4
Extended desktop, 8
external gain/loss correction, 66
External monitor, 8

F

Features, x

File types, 45

Free Run trigger mode, 48

Frequency edge
triggering, 48

Frequency mask
Mask Editor, 52
triggering, 48

Front panel
connectors, 19
controls, 15

G

General signal viewing displays, 26
Graphics driver, 11
Greater than (Mask Test), 61

Incoming inspection, 12
Information messages, 31

Index

Ink saver mode, 44
Input requirements

max DC voltage, 35

max measurable input

power, 35

max safe input power, 35

RF signal range, 35
Installation, 1

network connections, 5
is inside mask (Mask Test), 62
is outside mask (Mask Test), 62
Italicized numbers, 23

K

Key features, x

L

Less than (Mask Test), 61

Maintenance

cleaning procedures, 13

repackaging, 13
Marker toolbar, 40
Markers, 38

absolute, 39

adding, 40

defining, 41

delta, 39

DPX bitmap trace, 39

power, 39

reference, 39
Mask Editor

adding points, 52

editing points, 54
Mask Test, 59

Measurement

conflicts, 56
Mechanical specifications, 4
Messages

on-screen, 31
MR, 39

N

Network connections, 5
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Operating system restore, 7
Optional accessories, 2
Options

Power cords, 1

P

Pan

Touchscreen actions menu, 41
Part numbers, manuals, 1
Power cord options, 1
Power level triggering, 49
Power supply, 4
Preset, 34

selecting displays, 28, 30

system settings, 34
Printing, 43

ink saver mode, 44
Product features, x
Pulsed RF displays, 26

R

Real-Time spectrum analyzer, 24
Rear panel connectors, 20
Recalling data, 46
Repackaging, 13
Reset scale

Touchscreen actions menu, 41
Returning the instrument, 13
RF measurement displays, 26
RF signal connections, 35, 36
RF signal input range, 35
Run control, 37
Run menu, 37
Runt triggering, 49

S

Save options, 45
Saving data, 45
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Screens, printing, 43
Select
Touchscreen actions menu, 41
Selected window, 55
Selecting displays, 27
Settings
changing, 32
default, 34
preset, 34
Setups
recalling, 46
saving, 45
Software upgrades, xii
installing, 13
Span Zoom
Touchscreen actions menu, 41
Specifications
altitude, 4
cooling clearances, 4
environmental, 4
humidity, 4
input requirements, 35
mechanical, 4
power supply, 4
product dimensions, 4
temperature, 4
Spectrum analyzer
real-time concepts, 24
Standard accessories, 1
power cord, 1
Product Documentation, 1
Standards presets, 30
Starting acquisitions, 36
Stopping acquisitions, 36

.

Test using a mask, 61, 62
Testing signals, 59
Time Qualified

triggering, 48
touchscreen actions menu, 41

Trace legend, 32
Trigger
control panel, 50
mask, 52
violations, 55
Trigger Event parameters, 49
accessing, 50
Triggered trigger mode, 48
Triggering
DPX Density, 48
free run, 48
frequency edge, 48
frequency mask, 48
parameters, 49
power level, 49
Runt, 49
time qualified, 48
triggered mode, 48

U

Upgrades
software, xii, 13

vV

Violations
trigger mask, 55

w

Window
analysis, 24
selected, 55

V4

Zoom
Touchscreen actions menu, 41
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